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About This Book
WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.

iii



iv   About This Book



Table of contents

1  Product Features ............................................................................................................................................ 1
Microtower Models ............................................................................................................................... 4

Serviceability Features ........................................................................................................ 4
Front Panel Components ..................................................................................................... 4
Media Card Reader Components ........................................................................................ 5
Rear Panel Components ..................................................................................................... 6

HP Pro 3000 MT/3080 MT .................................................................................. 6
HP Pro 3010 MT ................................................................................................. 7

Small Form Factor Models ................................................................................................................... 8
Serviceability Features ........................................................................................................ 8
Front Panel Components ..................................................................................................... 8
Rear Panel Components ..................................................................................................... 9

HP Pro 3000 SFF ................................................................................................ 9
HP Pro 3010 SFF .............................................................................................. 10

2  Installing and Customizing the Software .................................................................................................... 11
Installing the Operating System .........................................................................................................  11
Downloading Microsoft Windows Updates ......................................................................................... 11
Installing or Upgrading Device Drivers (Windows systems) ............................................................... 12
Accessing Disk Image (ISO) Files ...................................................................................................... 12
Protecting the Software ...................................................................................................................... 12

3  Computer Setup (F10) Utility ....................................................................................................................... 13
HP Pro 3000/3080 – Computer Setup (F10) Utility ............................................................................ 13

Using Computer Setup (F10) Utilities ................................................................................ 13
Computer Setup—Main ..................................................................................................... 15
Computer Setup—Advanced ............................................................................................. 16
Computer Setup—Boot ...................................................................................................... 17
Computer Setup—Power ................................................................................................... 18
Computer Setup—PC Health ............................................................................................. 18
Computer Setup—Exit ....................................................................................................... 19

HP Pro 3010 – Computer Setup (F10) Utility ..................................................................................... 19
Using Computer Setup (F10) Utilities ................................................................................ 19
Computer Setup—Main ..................................................................................................... 20

v



Computer Setup—Advanced ............................................................................................. 21
Computer Setup—Power ................................................................................................... 23
Computer Setup—Boot ...................................................................................................... 23
Computer Setup—Exit ....................................................................................................... 24

4  Serial ATA (SATA) Drive Guidelines and Features .................................................................................... 25
SATA Hard Drives .............................................................................................................................. 25
SATA Hard Drive Cables .................................................................................................................... 25

SATA Data Cable .............................................................................................................. 25
SMART ATA Drives ............................................................................................................................ 26
Hard Drive Capacities ........................................................................................................................ 26

5  Identifying the Chassis, Routine Care, and Disassembly Preparation .................................................... 27
Electrostatic Discharge Information .................................................................................................... 27

Generating Static ............................................................................................................... 27
Preventing Electrostatic Damage to Equipment ................................................................ 28
Personal Grounding Methods and Equipment ................................................................... 28
Grounding the Work Area .................................................................................................. 29
Recommended Materials and Equipment .......................................................................... 29

Operating Guidelines .......................................................................................................................... 30
Routine Care ...................................................................................................................................... 31

General Cleaning Safety Precautions ................................................................................ 31
Cleaning the Computer Case ............................................................................................ 31
Cleaning the Keyboard ...................................................................................................... 31
Cleaning the Monitor .......................................................................................................... 32
Cleaning the Mouse ........................................................................................................... 32

Service Considerations ...................................................................................................................... 32
Power Supply Fan ............................................................................................................. 32
Tools and Software Requirements .................................................................................... 32
Screws ............................................................................................................................... 33
Cables and Connectors ..................................................................................................... 33
Hard Drives ........................................................................................................................ 33
Lithium Coin Cell Battery ................................................................................................... 34

6  Removal and Replacement Procedures Microtower (MT) Chassis .......................................................... 35
Preparation for Disassembly .............................................................................................................. 35
Access Panel ...................................................................................................................................... 36
Front Bezel ......................................................................................................................................... 37
Bezel Blanks ....................................................................................................................................... 38
Memory .............................................................................................................................................. 39

DDR3-SDRAM DIMMs ...................................................................................................... 39
Populating DIMM Sockets ................................................................................................. 40
Installing Memory Modules ................................................................................................ 42

vi



Expansion Cards ................................................................................................................................ 44
Cable Management ............................................................................................................................ 49

Cable Connections ............................................................................................................ 50
HP Pro 3000/3080 ............................................................................................. 50
HP Pro 3010 ...................................................................................................... 51

Drives ................................................................................................................................................. 52
Drive Positions ................................................................................................................... 52
Installing Additional Drives ................................................................................................. 53

System Board Drive Connections ..................................................................... 54
Removing an Optical Drive ............................................................................... 56
Installing an Optical Drive into the 5.25-inch Drive Bay .................................... 57
Removing an External 3.5-inch Drive ................................................................ 58
Installing a Drive into the 3.5-inch External Drive Bay ...................................... 59
Removing an Internal 3.5-inch Hard Drive ........................................................ 60
Installing an Internal 3.5-inch Hard Drive .......................................................... 64

Front I/O and USB Panel Housing Assembly ..................................................................................... 67
Power Switch/LED Assembly ............................................................................................................. 68
System Fan ........................................................................................................................................ 69
Heat sink assembly ............................................................................................................................ 70
Processor ........................................................................................................................................... 71
Power Supply ..................................................................................................................................... 72
System Board ..................................................................................................................................... 74
Battery ................................................................................................................................................ 75

Type 1 Battery Holder ........................................................................................................ 76
Type 2 Battery Holder ........................................................................................................ 77
Type 3 Battery Holder ........................................................................................................ 77

Installing a Security Lock .................................................................................................................... 79
HP/Kensington MicroSaver Security Cable Lock ............................................................... 79
Padlock .............................................................................................................................. 79
HP Business PC Security Lock .......................................................................................... 80
Hood Sensor ...................................................................................................................... 82
HP Chassis Security Kit ..................................................................................................... 83

7  Removal and Replacement Procedures Small Form Factor (SFF) Chassis ............................................ 84
Preparation for Disassembly .............................................................................................................. 84
Access Panel ...................................................................................................................................... 85
Front Bezel ......................................................................................................................................... 86
Bezel Blanks ....................................................................................................................................... 87
Memory .............................................................................................................................................. 88

DDR3-SDRAM DIMMs ...................................................................................................... 88
Populating DIMM Sockets ................................................................................................. 89
Installing DIMMs ................................................................................................................ 91

Removing or Installing an Expansion Card ........................................................................................ 94

vii



Cable Management ............................................................................................................................ 99
Cable Connections .......................................................................................................... 100

HP Pro 3000/3080 ........................................................................................... 100
HP Pro 3010 .................................................................................................... 100

Drives ............................................................................................................................................... 101
Drive Positions ................................................................................................................. 101
Installing Additional Drives ............................................................................................... 102

System Board Drive Connectors ..................................................................... 103
Removing an Optical Drive ............................................................................. 105
Installing an Optical Drive into the 5.25-inch Drive Bay .................................. 106
Removing an External 3.5-inch Drive .............................................................. 108
Installing a Drive into the 3.5-inch External Drive Bay .................................... 110
Removing an Internal 3.5-inch Hard Drive ...................................................... 113
Installing an Internal 3.5-inch Hard Drive ........................................................ 115

Plastic Wire/Cable Fastener and Clips ............................................................................................. 117
Front I/O Device ............................................................................................................................... 119
Power Switch Assembly ................................................................................................................... 120
Heatsink ........................................................................................................................................... 121
Processor ......................................................................................................................................... 122
Power Supply ................................................................................................................................... 123
System Board ................................................................................................................................... 125
Battery .............................................................................................................................................. 126

Type 1 Battery Holder ...................................................................................................... 127
Type 2 Battery Holder ...................................................................................................... 127
Type 3 Battery Holder ...................................................................................................... 128

Installing a Security Lock .................................................................................................................. 129
HP/Kensington MicroSaver Security Cable Lock ............................................................. 129
Padlock ............................................................................................................................ 129
HP Business PC Security Lock ........................................................................................ 130
Hood Sensor .................................................................................................................... 132
HP Chassis Security Kit ................................................................................................... 133

Appendix A  Connector Pin Assignments .................................................................................................... 134
Ethernet BNC ................................................................................................................................... 134
USB .................................................................................................................................................. 134
Microphone ....................................................................................................................................... 134
Headphone ....................................................................................................................................... 135
Line-in Audio .................................................................................................................................... 135
Line-out Audio .................................................................................................................................. 135
4-Pin Power (for CPU) ...................................................................................................................... 135
Monitor ............................................................................................................................................. 136
24-Pin Power .................................................................................................................................... 136
PCI Express ..................................................................................................................................... 137

viii



PCI Express ..................................................................................................................................... 138

Appendix B  Power Cord Set Requirements ................................................................................................ 139
General Requirements ..................................................................................................................... 139
Japanese Power Cord Requirements .............................................................................................. 139
Country-Specific Requirements ........................................................................................................ 140

Appendix C  Troubleshooting Without Diagnostics .................................................................................... 141
Safety and Comfort .......................................................................................................................... 141
Before You Call for Technical Support ............................................................................................. 141
Helpful Hints ..................................................................................................................................... 142
Solving General Problems ................................................................................................................ 144
Solving Power Problems .................................................................................................................. 147
Solving Hard Drive Problems ........................................................................................................... 148
Solving Media Card Reader Problems ............................................................................................. 149
Solving Display Problems ................................................................................................................. 151
Solving Audio Problems ................................................................................................................... 155
Solving Printer Problems .................................................................................................................. 156
Solving Keyboard and Mouse Problems .......................................................................................... 158
Solving Hardware Installation Problems ........................................................................................... 160
Solving Network Problems ............................................................................................................... 162
Solving Memory Problems ............................................................................................................... 165
Solving CD-ROM and DVD Problems .............................................................................................. 166
Solving USB Flash Drive Problems .................................................................................................. 168
Solving Front Panel Component Problems ...................................................................................... 169
Solving Internet Access Problems .................................................................................................... 170
Solving Software Problems .............................................................................................................. 172
Interpreting POST Audible Codes .................................................................................................... 173
Resetting the Password Jumper ...................................................................................................... 174
Resetting the CMOS Jumper ........................................................................................................... 175
Contacting Customer Support .......................................................................................................... 176

Appendix D  Specifications ............................................................................................................................ 177
Microtower ........................................................................................................................................ 177
Small Form Factor ............................................................................................................................ 180

Index ................................................................................................................................................................. 182

ix



x



1 Product Features

Two different chassis are available—microtower and small form factor.

HP Pro Business PC features vary depending on model. For a complete listing of the hardware and
software installed in the computer, run the diagnostic utility (included on some computer models
only).

Figure 1-1  HP Pro 3000 Microtower
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Figure 1-2  HP Pro 3000/3010 Small Form Factor

Figure 1-3  HP Pro 3010 Microtower
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Figure 1-4  HP Pro 3080 Microtower
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Microtower Models
Serviceability Features

The Microtower computer includes features that make it easy to upgrade and service. A Torx T-15 or
flat blade screwdriver is needed for many of the installation procedures described in this guide.

Front Panel Components
Front bezel appearance and drive configuration varies by model.

Figure 1-5  Front Panel Components

Table 1-1  Front Panel Components

1 5.25-inch Optical Drive1 6 Hard Drive Activity Light

2 5.25-inch Optical Drive Bay 7 Optical Drive Eject Button

3 3.5-inch Media Card Reader (optional)2 8 Microphone Connector

4 Recovery/Reset Button3 9 Headphone Connector

5 Dual-State Power Button 10 USB (Universal Serial Bus) 2.0 Ports

1 Some models have bezel blanks covering one or both of the 5.25-inch drive bays.
2 Some models have a bezel blank covering the 3.5-inch drive bay.
3 Not available on all models
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Media Card Reader Components
The media card reader is an optional device available on some models only. Refer to the following
illustration and table to identify the media card reader components.

Figure 1-6  Media Card Reader Components

Table 1-2  Media Card Reader Components

No. Slot Media   

1 xD ● xD-Picture Card (xD)   

2 MicroSD ● MicroSD (T-Flash) ● MicroSDHC  

3 Media Card Reader
Activity Light

   

4 SD/MMC+/miniSD ● Secure Digital (SD)

● Secure Digital High
Capacity (SDHC)

● MiniSD

● MiniSDHC

● MultiMediaCard
(MMC)

● Reduced Size
MultiMediaCard (RS
MMC)

● MultiMediaCard 4.0
(MMC Plus)

● Reduced Size
MultiMediaCard 4.0
(MMC Mobile)

● MMC Micro (adapter
required)

5 USB ● USB (Universal Serial
Bus) Port

  

6 CompactFlash I/II ● CompactFlash Card
Type 1

● CompactFlash Card
Type 2

● MicroDrive

7 MS PRO/MS PRO DUO ● Memory Stick (MS)

● MagicGate Memory
Stick (MG)

● MagicGate Memory
Duo

● Memory Stick Select

● Memory Stick Duo
(MS Duo)

● Memory Stick PRO
(MS PRO)

● Memory Stick PRO
Duo (MS PRO Duo)

● Memory Stick PRO-
HG Duo

● Memory Stick Micro
(M2) (adapter
required)

Microtower Models 5



Rear Panel Components

HP Pro 3000 MT/3080 MT
Figure 1-7  Rear Panel Components – HP Pro 3000/3080 MT

Table 1-3  Rear Panel Components – HP Pro 3000/3080 MT

1 Power Cord Connector 7 Line-Out Connector for powered audio
devices (green)

2 Line-In Audio Connector (blue) 8 Microphone Connector (pink)

3 RJ-45 Network Connector 9 DVI Connector

4 Universal Serial Bus (USB) Ports 10 Serial connector

5 VGA Monitor Connector 11 Keyboard PS/2 connector

6 Mouse PS/2 connector   

NOTE: Arrangement and number of connectors may vary by model.

When a device is plugged into the blue Line-In Audio Connector, a dialog box will pop up asking if
you want to use the connector for a line-in device or a microphone. You can reconfigure the
connector at any time by double-clicking the Realtek HD Audio Manager icon in the Windows taskbar.
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HP Pro 3010 MT
Figure 1-8  Rear Panel Components – HP Pro 3010 MT

Table 1-4  Rear Panel Components – HP Pro 3010 MT

1 Power Cord Connector 7 Line-Out Connector for powered audio
devices (green)

2 Line-In Audio Connector (blue) 8 Microphone Connector (pink)

3 Rear Center Channel/Subwoofer Audio
Connector (orange)

9 Surround Side Channel Audio
Connector (gray)

4 RJ-45 Network Connector 10 Surround Rear Channel Audio
Connector (black)

5 VGA Monitor Connector 11 Universal Serial Bus (USB) Ports

6 Digital Audio Out Connector 12 DVI Connector

NOTE: Arrangement and number of connectors may vary by model.

When a device is plugged into the blue Line-In Audio Connector, a dialog box will pop up asking if
you want to use the connector for a line-in device or a microphone. You can reconfigure the
connector at any time by double-clicking the Realtek HD Audio Manager icon in the Windows taskbar.
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Small Form Factor Models
Serviceability Features

The small form factor computer includes features that make it easy to upgrade and service. A Torx
T-15 or flat blade screwdriver is needed for many of the installation procedures described in this
guide.

Front Panel Components
Drive configuration may vary by model.

Figure 1-9  Front Panel Components

Table 1-5  Front Panel Components

1 Media card reader (optional)2 6 USB (Universal Serial Bus) 2.0 Ports

2 5.25-inch Optical Drive (optional)1 7 Microphone Connector

4 Hard Drive Activity Light 8 Headphone Connector

3 Optical Drive Activity Light 9 Power On Light

5 Optical Drive Eject Button 10 Dual-State Power Button

1 Some models have a bezel blank covering the 3.5-inch drive bay.
2 Some models have a bezel blank covering the 5.25-inch drive bay.

8 Chapter 1   Product Features



Rear Panel Components

HP Pro 3000 SFF
Figure 1-10  Rear Panel Components – HP Pro 3000 SFF

Table 1-6  Rear Panel Components – HP Pro 3000 SFF

1 Mouse PS/2 Connector 7 Serial Connector

2 VGA Monitor Connector (blue) 8 DVI Connector

3 RJ-45 Network Connector 9 Universal Serial Bus (USB) Ports

4 Line-In Audio Connector (blue) 10 Microphone Connector (pink)

5 Power Cord Connector 11 Line-Out Connector for powered audio
devices (green)

6 Keyboard PS/2 Connector 12 Voltage Select Switch

NOTE: Arrangement and number of connectors may vary by model.

The monitor connector on the system board is inactive when a PCI Express x16 graphics card is
installed in the computer.

If a PCI Express x1 graphics card is installed, the connectors on the card and the system board may
be used at the same time. Some settings may need to be changed in Computer Setup to use both
connectors. For information about setting the boot VGA controller, refer to the Computer Setup (F10)
Utility Guide.
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HP Pro 3010 SFF
Figure 1-11  Rear Panel Components – HP Pro 3010 SFF

Table 1-7  Rear Panel Components – HP Pro 3010 SFF

1 Digital Audio Out Connector 8 Universal Serial Bus (USB) Ports

2 VGA Monitor Connector (blue) 9 Surround Rear Channel Audio
Connector (black)

3 RJ-45 Network Connector 10 Surround Side Channel Audio
Connector (gray)

4 Rear Center Channel/Subwoofer Audio
Connector (orange)

11 Microphone Connector (pink)

5 Line-In Audio Connector (blue) 12 Line-Out Connector for powered audio
devices (green)

6 Power Cord Connector 13 Voltage Select Switch

7 DVI Connector   

NOTE: Arrangement and number of connectors may vary by model.

The monitor connector on the system board is inactive when a PCI Express x16 graphics card is
installed in the computer.

If a PCI Express x1 graphics card is installed, the connectors on the card and the system board may
be used at the same time. Some settings may need to be changed in Computer Setup to use both
connectors. For information about setting the boot VGA controller, refer to the Computer Setup (F10)
Utility Guide.
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2 Installing and Customizing the
Software

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

NOTE: If the computer was shipped with Windows Vista or Windows 7 loaded, you will be prompted
to register the computer with HP Total Care before installing the operating system. You will see a
brief movie followed by an online registration form. Fill out the form, click the Begin button, and follow
the instructions on the screen.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

NOTE: Be sure there is a 10.2-cm (4-inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Installing the Operating System
The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER
UNTIL THE PROCESS IS COMPLETE. Turning off the computer during the installation process may
damage the software that runs the computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive,
the installation process could take up to 60 minutes.

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

Downloading Microsoft Windows Updates
1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on

the screen.

2. Once an Internet connection has been established, click the Start button.

3. Select the All Programs menu.

Installing the Operating System 11



4. Click on the Windows Update link.

In Windows Vista and Windows 7, the Windows Update screen appears. Click view available
updates and make sure all critical updates are selected. Click the Install button and follow the
instructions on the screen.

In Windows XP, you will be directed to the Microsoft Windows Update Web site. If you see
one or more pop-up windows that ask you to install a program from http://www.microsoft.com,
click Yes to install the program. Follow the instructions on the Microsoft Web site to scan for
updates and install critical updates and service packs.

It is recommended that you install all of the critical updates and service packs.

5. After the updates have been installed, Windows will prompt you to reboot the machine. Be sure
to save any files or documents that you may have open before rebooting. Then select Yes to
reboot the machine.

Installing or Upgrading Device Drivers (Windows
systems)

When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C:\i386, or use the Browse
button in the dialog box to locate the i386 folder. This action points the operating system to the
appropriate drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Accessing Disk Image (ISO) Files
There are disk image files (ISO files) included on your PC that contain the installation software for
additional software. These CD image files are located in the folder C:\SWSetup\ISOs. Each .iso file
can be burned to CD media to create an installation CD. It is recommended that these disks be
created and the software installed in order to get the most from your PC. The software and image file
names are:

● Corel WinDVD SD and BD – installation software for WinDVD – used to play DVD movies

● HP Insight Diagnostics OR Vision Diagnostics – software to perform diagnostic activities on your
PC

Protecting the Software
To protect the software from loss or damage, keep a backup copy of all system software,
applications, and related files stored on the hard drive. Refer to the operating system or backup utility
documentation for instructions on making backup copies of your data files.
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3 Computer Setup (F10) Utility

The computer setup utility differs for the HP Pro 3000/3080 and the HP Pro 3010.

HP Pro 3000/3080 – Computer Setup (F10) Utility
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, or
USB flash media devices.

● Restrict a device from booting the unit.

● Run hard drive self-tests.

● View CPU and system temperatures.

● Establish a supervisor password that controls access to Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

● Enable or disable pre-boot messages.

● Enable or disable USB legacy support.

Using Computer Setup (F10) Utilities
Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. As soon as the computer is turned on, press F10 before the system boots to the operating
system to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and
again press F10 before the unit boots to the operating system to access the utility.

3. The Computer Setup Utility screen is divided into menu headings and actions.

HP Pro 3000/3080 – Computer Setup (F10) Utility 13



Six menu headings appear on the Computer Setup Utility screen:

● Main

● Advanced

● Boot

● Power

● PC Health

● Exit

Use the arrow keys to select the appropriate heading, then press Enter. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the previous screen,
press Esc.

4. To apply and save changes, press the F10 key.

If you have made changes that you do not want applied, press the F5 key to return to the
previous values.

To load optimized default values, press the F7 key.

CAUTION: Do NOT turn the computer power OFF while the ROM is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.

Table 3-1  Computer Setup (F10) Utility Main Menu

Heading Table

Main Computer Setup—Main on page 15

Advanced Computer Setup—Advanced on page 16

Boot Computer Setup—Boot on page 17

Power Computer Setup—Power on page 18

PC Health Computer Setup—PC Health on page 18

Exit Computer Setup—Exit on page 19
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Computer Setup—Main
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-2  Computer Setup—Main

Option Description

System Information Allows you to view the following system information:

● Product Name (view only)

● SKU Number (view only)

● Processor Type (view only)

● Processor Speed (view only)

● CPUID/PatchID (view only)

● Cache Size (view only)

● Memory Size (view only)

● Integrated MAC (view only)

● System BIOS (view only)

● Chassis Serial Number (view only)

● Asset Tag Number (press Enter to change)

● UUID (view only)

Set Time and Date Allows you to set system time and date.

SATA Port 1

SATA Port 2

SATA Port 3

SATA Port 4

Allows or displays the following for each SATA Port:

● Port Configuration — Disable/enable SATA Port

● HDD Self-Test for selected channel:

◦ SMART Status Check

◦ HDD Short Self-Test

◦ HDD Extended Self-Test

● Vendor (view only)

● Size (view only)

● Firmware (view only)

SATA Emulation Allows you to choose how the SATA controller and devices are accessed by the operating
system. The following options are available:

● IDE

● RAID

● AHCI

Onboard FDC
Controller

Disables/enables the floppy disk controller.

Drive A (view only)

HP Pro 3000/3080 – Computer Setup (F10) Utility 15



Option Description

Halt On Allows you to set POST error behavior to:

● No Errors

● All Errors

● All But Keyboard

POST Delay Allows you to set a POST delay to:

● 0 seconds

● 5 seconds

● 10 seconds

● 15 seconds

● 30 seconds

Computer Setup—Advanced
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-3  Computer Setup—Advanced

Option Description

Execute Disable Bit Disables/enables hardware DEP function.

Init Display First Allows you to select the primary display device:

● OnChip VGA

● PCI Slot

● PCIEx

MAX DVMT Allocation Allows you to specify the DVMT/system memory allocated for video memory.:

● 128MB

● 256MB

● Max

Onboard HD Audio Allows you to disable/enable onboard HD audio.

OnChip USB
Controller

Disables/enables the universal host controller interface for USB (Universal Serial Bus).

USB Legacy Support Disables/enables USB legacy support function (USB keyboard, USB mouse, and USB flash
media).

Onboard LAN Disables/enables onboard LAN controller.

Onboard LAN Boot
ROM

Disables/enables the boot ROM of the onboard LAN chip.

Table 3-2  Computer Setup—Main (continued)
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Option Description

Onboard Serial Port 1 Allows you to select a setting for the onboard serial port:

● Disabled

● 3F8/IRQ4

● 2F8/IRQ3

● 3E8/IRQ4

● 2E8/IRQ3

PCI Device SERR# Disables/enables SERR#.

Computer Setup—Boot
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-4  Computer Setup—Boot

Option Description

F9 Boot Menu Disables/enables F9 Boot Menu.

F10 Setup Prompt Disables/enables the F10 Setup prompt message on the logo screen.

F11 Recovery Disables/enables F11 Recovery and provides the option of showing the F11 Recovery prompt
message on the logo screen. Choose from the following:

● Disabled

● Enabled no prompt

● Enabled and prompt

F12 Boot from LAN
Prompt

Disables/enables the F12 Boot from LAN prompt message on the logo screen.

Hard Disk Boot Seq. Allows you to specify the order of attached hard drive devices (such as USB HDD storage or USB
flash media). The first drive in the order has priority in the boot sequence and is recognized as
drive C (if any devices are attached).

Optical Drive Boot
Seq.

Allows you to specify the order in which attached optical drives (including USB ODD) are checked
for a bootable operating system image.

Network Boot Seq. Allows you to specify the order in which network devices (including UP NIC cards) are checked for
a bootable operating system image.

First Boot Device

Second Boot Device

Third Boot Device

Fourth Boot Device

Allows you to specify which devices will boot first, second, third, and fourth or to disable any of the
four:

● Removable

● CDROM

● Hard Disk

● Network

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Table 3-3  Computer Setup—Advanced (continued)
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Option Description

Set Supervisor
Password

Allows you to establish a password to control access to Computer Setup.

BIOS Write Protection Disables/enables BIOS upgrading.

Computer Setup—Power
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-5  Computer Setup—Power

Option Description

After AC Power Loss Allows you to select system power loss behavior:

● Off

● On

● Last State

Wake on PCI Device
from S5

Disables/enables waking up from S5 by PCI device.

RTC Alarm Resume Disables/enables RTC (real-time clock) alarm.

Computer Setup—PC Health
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-6  Computer Setup—PC Health

Option Description

Chassis Opened
Warning

Allows you to disable/enable the chassis intrusion function and clear the intrusion warning.

System Fan Fail
Check

Disables/enables detection of system fan during POST.

Smart Fan Function Disables/enables Smart Fan functionality. Enabling optimizes fan control for best acoustic
behavior.

Current CPU
Temperature

(view only)

Current System
Temperature

(view only)

Current CPU Fan
Speed

(view only)

Current System Fan
Speed

(view only)

Table 3-4  Computer Setup—Boot (continued)
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Computer Setup—Exit
Table 3-7  Computer Setup—Exit

Option Description

Save Changes and Exit Allows you to save current settings and exit Computer Setup.

Discard Changes and
Exit

Allows you to exit Computer Setup without saving changes.

Load Optimal Defaults Allows you to reset Computer Setup to factory defaults.

HP Pro 3010 – Computer Setup (F10) Utility
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, or
USB flash media devices.

● Restrict a device from booting the unit.

● Run hard drive self-tests.

● View CPU and system temperatures.

● Establish a supervisor password that controls access to Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

● Enable or disable pre-boot messages.

● Enable or disable USB legacy support.

Using Computer Setup (F10) Utilities
Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. As soon as the computer is turned on, press F10 before the system boots to the operating
system to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and
again press F10 before the unit boots to the operating system to access the utility.

3. The Computer Setup Utility screen is divided into menu headings and actions.
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Five menu headings appear on the Computer Setup Utility screen:

● Main

● Advanced

● Boot

● Power

● Exit

Use the arrow keys to select the appropriate heading, then press Enter. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the previous screen,
press Esc.

4. To apply and save changes, press the F10 key.

If you have made changes that you do not want applied, press the F5 key to return to the
previous values.

To load optimized default values, press the F7 key.

CAUTION: Do NOT turn the computer power OFF while the ROM is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.

Table 3-8  Computer Setup (F10) Utility Main Menu

Heading Table

Main Computer Setup—Main on page 15

Advanced Computer Setup—Advanced on page 16

Boot Computer Setup—Boot on page 17

Power Computer Setup—PC Health on page 18

Exit Computer Setup—Exit on page 24

Computer Setup—Main
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-9  Computer Setup—Main

Option Description

System Time Allows you to set system time.

System Date Allows you to set system date.

Language Allows you to select language.

20 Chapter 3   Computer Setup (F10) Utility



Floppy Diskette A: Allows you to set drive A to:

● Disabled

● 1.44 MB 3.5”

● Not Installed

1st Drive

2nd Drive

3rd Drive

4th Drive

For each, allows you to:

● (view only)

◦ Capacity (Size - HDD only)

◦ Transfer Mode

● Smart Support - run HDD self-test for selected channel:

◦ SMART Status Check

◦ SMART Short Self-Test

◦ SMART Extended Self-Test

System Information (view only)

● Installed Memory

● Memory Bank 1

● Memory Bank 2

● Memory Bank 3

● Memory Bank 4

● BIOS Revision

● Core Version

● Product Number

● Model Number (press Enter to change)

● Serial Number (press Enter to change)

● Asset Tag (press Enter to change)

Computer Setup—Advanced
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

WARNING! Setting items on this menu to incorrect values may cause your system to malfunction.

Table 3-10  Computer Setup—Advanced

Option Description

CPU Type (view only)

CPU Speed (view only)

Cache RAM (view only)

Table 3-9  Computer Setup—Main (continued)
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Primary Video Adapter Allows you to select the boot display device when more than 2 video options are offered by the
system:

● Onboard

● PCI-E

Security Option Checks password while invoking Setup or while invoking Setup as well as on each System boot.
Set to:

● Setup

● System

Supervisor Password Allows you to view the supervisor password.

User Password Allows you to view the user password.

USB Ports Allows you to enable/disable individual USB ports (USB Port 1 through USB Port 12).

Onboard Video
Memory Size

Allows you to set onboard video memory size to:

● 128MB

● 256MB

● 512MB

SATA Controller Allows you to disable/enable the SATA1 Controller.

SATA Controller Mode If SATA1 Controller is enabled, allows you to set the mode to:

● IDE

● AHCI

Onboard Audio Allows you to set the onboard audio to:

● Enabled

● Disabled

● Auto

Onboard LAN Allows you to disable/enable onboard LAN controller.

Onboard LAN Boot
ROM

Allows you to disable/enable the boot ROM of the onboard LAN chip.

Change Supervisor
Password

Allows you to change the supervisor password.

Table 3-10  Computer Setup—Advanced (continued)
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Computer Setup—Power
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-11  Computer Setup—Power

Option Description

After AC Power
Failure

Allows you to select system restart behavior after power loss:

● Stay Off

● Power On

● Auto

XD (Execute Disable) Disables/enables the processor's XD feature.

Computer Setup—Boot
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-12  Computer Setup—Boot

Option Description

Boot-time Diagnostic
Screen

Disables/enables POST diagnostic messages display.

Esc: Boot Menu Disables/enables POST Esc: Boot Menu message display,

F9: Diagnostics Disables/enables POST F9: Diagnostics message display,

F10: Setup Disables/enables POST F10: Setup message display,

F11: Recovery Disables/enables POST F11: Recovery message display,

F12: Boot From LAN Disables/enables POST F12: Boot From LAN message display,

(Boot Device Priority)

1st Boot Device

2nd Boot Device

3rd Boot Device

4th Boot Device

Allows you to specify which device groups will boot first, second, third, and fourth or to disable any
of the four:

● CD-ROM Group

● Hard Drive Group

● Floppy Group

● Network Boot Group

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Floppy Group Boot
Priority

Specifies boot device priority within removable devices.

CD-ROM Group Boot
Priority

Specifies boot device priority within CD/DVD drives.
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HDD Group Boot
Priority

Specifies boot device priority within hard drives.

Network Group Boot
Priority

Specifies boot device priority within bootable network devices.

Computer Setup—Exit
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-13  Computer Setup—Exit

Option Description

Exit Saving Changes Press Enter to exit saving changes.

Exit Discarding
Changes

Press Enter to exit discarding changes.

Load Setup Defaults Press Enter to load setup defaults.

Discard Changes Press Enter to discard changes.

Save Changes Press Enter to save changes.

Table 3-12  Computer Setup—Boot (continued)
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4 Serial ATA (SATA) Drive Guidelines
and Features

NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel
ATA (PATA) drives are supported.

SATA Hard Drives
Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Hard Drive Cables

SATA Data Cable
Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.
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SMART ATA Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

 Maximum Size

File System Controller Type Operating System Partition Drive

FAT 32 ATA Windows 2000/XP/Vista 32 GB 2 TB

NTFS ATA Windows 2000/XP/Vista 2 TB 2 TB
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5 Identifying the Chassis, Routine Care,
and Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static
The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs* from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V
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Removing DIPs* from vinyl tray

Removing DIPs* from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.

● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal Grounding Methods and Equipment
Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000
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Grounding the Work Area
To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment
Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes
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Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

● Never operate the computer with the cover or side panel removed.

● Do not stack computers on top of each other or place computers so near each other that they
are subject to each other’s re-circulated or preheated air.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation
must be provided on the enclosure, and the same operating guidelines listed above will still
apply.

● Keep liquids away from the computer and keyboard.

● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software,
including sleep states.
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Routine Care

General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case
Follow all safety precautions in General Cleaning Safety Precautions on page 31 before cleaning the
computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the Keyboard
Follow all safety precautions in General Cleaning Safety Precautions on page 31 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 31.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 31 before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.
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● If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor
● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for

cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 31.

Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 31.

Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power Supply Fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Tools and Software Requirements
To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver
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● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws
The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and Connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic Discharge Information on page 27

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.
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Lithium Coin Cell Battery
The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.
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6 Removal and Replacement Procedures
Microtower (MT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly
1. Close any open software applications.

2. Exit the operating system.

3. Remove any diskette or compact disc from the computer.

4. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. In some systems the cooling fan is on
even when the computer is in the “Standby,” or “Suspend” modes. The power cord should
always be disconnected before servicing a unit.

5. Disconnect the power cord from the electrical outlet and then from the computer.

6. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.
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Access Panel
1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Loosen the screw (1) that secures the access panel to the computer chassis.

3. Slide the access panel back (2) about 1.3 cm (1/2 inch), then lift it off the unit.

NOTE: You may want to lay the computer on its side to install internal parts. Be sure the side
with the access panel is facing up.

Figure 6-1  Removing the Computer Access Panel

To replace the access panel, reverse the removal steps.
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Front Bezel
1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Press outward on the three latches on the right side of the bezel (1), then rotate the right side of
the bezel off the chassis (2) followed by the left side.

Figure 6-2  Removing the Front Bezel

NOTE: The appearance of the front bezel may vary.

To reinstall the front bezel, reverse the removal procedure.
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Bezel Blanks
On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that
need to be removed before installing a drive. To remove a bezel blank:

1. Remove the front bezel (Front Bezel on page 37).

2. To remove the lower 5.25-inch bezel blank, gently twist and pull on the bezel blank until it breaks
free from the front bezel (1), then discard the bezel blank. If the blank needs to be replaced at a
later date, you can order a replacement blank from HP.

3. To remove the 3.5-inch bezel blank, press the two retaining tabs towards the outer left edge of
the bezel (2) and pull the bezel blank inwards to free it from the front bezel (3).

Figure 6-3  Removing a Bezel Blank

4. Replace the front bezel.
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Memory
The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DDR3-SDRAM DIMMs
The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 8 GB of memory configured in a high-
performing dual channel mode.

For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-10600 DDR3-1333 MHz-compliant

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 9 DDR3 1333 MHz (9-9-9 timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets
There are four DIMM sockets on the system board, with two sockets per channel.

Populate the DIMM sockets in the following order: DIMM1, DIMM3, DIMM2, then DIMM4.

40 Chapter 6   Removal and Replacement Procedures Microtower (MT) Chassis



Figure 6-4  DIMM Socket Locations – HP Pro 3010

Table 6-1  DIMM Socket Locations

Item Description Socket Color (HP Pro 3000/3080) Socket Color
(HP Pro 3010)

Insertion Order

1 XMM1 socket, Channel A (populate
first)

White Blue 1

2 XMM2 socket, Channel B Black Black 3

3 XMM3 socket, Channel A (populate
second)

White Blue 2

4 XMM4 socket, Channel B Black Black 4

NOTE: A DIMM must occupy the XMM1/DIMM1 socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

● The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B.
The technology and device width can vary between the channels. For example, if Channel A is
populated with two 1-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

● The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel
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populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. For optimal speed, the channels
should be balanced so that the largest amount of memory is spread between the two channels.
If one channel will have more memory than the other, the larger amount should be assigned to
Channel A. For example, if you are populating the sockets with one 2-GB DIMM, and three 1-GB
DIMMs, Channel A should be populated with the 2-GB DIMM and one 1-GB DIMM, and Channel
B should be populated with the two 1-GB DIMMs. With this configuration, 4-GB will run as dual
channel and 1 GB will run as single channel.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing Memory Modules
CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Locate the memory module sockets on the system board.

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.
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4. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

Figure 6-5  Installing a DIMM

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

A DIMM must occupy the XMM1 socket.

To create a dual-channel memory configuration, the memory capacity of Channel A must equal
the memory capacity of Channel B. Refer to Populating DIMM Sockets on page 40 for more
information.

5. Push the DIMM module down firmly into the socket, ensuring that the module is fully inserted
and properly seated. The DIMM must be pushed all the way down into the socket and sit evenly
in the socket to avoid memory corruption. Make sure the latches are in the closed position (3).

6. Repeat steps 4 and 5 to install any additional modules.

7. Replace the computer access panel.

8. Reconnect the power cord and any external devices, then turn on the computer. The computer
should automatically recognize the additional memory when you turn on the computer.

9. Lock any security devices that were disengaged when the access panel was removed.
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Expansion Cards
The HP Pro 3000 and HP Pro 3080 has two PCI slots, one PCI Express x1 expansion slots, and one
PCI Express x16 expansion slot. The expansion slots accommodate full-height or half-height
expansion cards.

Figure 6-6  Expansion Slot Locations – HP Pro 3000/3080

Table 6-2  Expansion Slot Locations – HP Pro 3000/3080

Item Description

1 PCI expansion slot

2 PCI expansion slot

3 PCI Express x1 expansion slot

4 PCI Express x16 expansion slot

The HP Pro 3010 has three PCI Express x1 expansion slots and one PCI Express x16 expansion
slot. The expansion slots accommodate full-height or half-height expansion cards.
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Figure 6-7  Expansion Slot Locations – HP Pro 3010

Table 6-3  Expansion Slot Locations – HP Pro 3010

Item Description

1 PCI Express x1 expansion slot

2 PCI Express x1 expansion slot

3 PCI Express x1 expansion slot

4 PCI Express x16 expansion slot

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16
expansion slot.

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Locate the correct vacant expansion socket on the system board and the corresponding
expansion slot on the back of the computer chassis.
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4. On the rear of the computer, a slot cover lock secures the expansion card brackets in place.
Remove the screw from the slot cover lock then slide the slot cover lock up to remove it from the
chassis.

Figure 6-8  Opening the Slot Cover Lock

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

a. If you are installing an expansion card in a vacant socket, you must use a flatblade
screwdriver to pry out the metal shield on the rear panel that covers the expansion slot. Be
sure to remove the appropriate shield for the expansion card you are installing.

Figure 6-9  Removing an Expansion Slot Cover
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b. If you are removing a standard PCI card or PCI Express x1 card, hold the card at each end,
and carefully rock it back and forth until the connectors pull free from the socket. Pull the
expansion card straight up from the socket then away from the inside of the chassis to
release it from the chassis frame. Be sure not to scrape the card against the other
components.

Figure 6-10  Removing a PCI or PCI Express x1 Expansion Card

c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Be sure not to scrape the card against the other
components.

Figure 6-11  Removing a PCI Express x16 Expansion Card

6. Store the removed card in anti-static packaging.
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7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.

8. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis so that the bottom of the bracket on the
card slides into the small slot on the chassis. Press the card straight down into the expansion
socket on the system board.

Figure 6-12  Installing an Expansion Card

NOTE: When installing an expansion card, press firmly on the card so that the whole
connector seats properly in the expansion card slot.

9. Replace the slot cover lock and secure it in place with the screw that was previously removed.

Figure 6-13  Securing the Expansion Cards and Slot Covers
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10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Replace the computer access panel.

12. Reconnect the power cord and any external devices, then turn on the computer.

13. Lock any security devices that were disengaged when the access panel was removed.

14. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide for
instructions on using Computer Setup.

Cable Management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heatsink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cable from the connector on the system board, always follow
these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).
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2. Grasp the cable end of the connector and pull it straight up (2).

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.

Cable Connections

HP Pro 3000/3080
System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

PWR white Power supply, 24-pin

PWRCPU white Power supply, 4-pin

CHFAN1 maroon Chassis fan

CPUFAN white Heat sink fan

FRNT AUDIO yellow Front I/O audio

FRNT USB1 white Front I/O USB

JFP1 black Power button

FRNT USB2 white Media card reader

SATA1 dark blue Primary hard drive

SATA2 white Primary optical drive

SATA3 light blue Second hard drive

SATA4 orange Second optical drive

SPKR white Speaker

MEDIA black Media card reader
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HP Pro 3010
System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

Not labeled white Power supply, 24-pin

ATX_CPU white Power supply, 4-pin

CHASSIS_FAN1 maroon Chassis fan

CPU_FAN white Heat sink fan

J_AUDIO yellow Front I/O audio

J_USB1 white Front I/O USB

F_PANEL black Power button

JUSB2 white Media card reader

SATA0 dark blue Primary hard drive

SATA1 white Primary optical drive

SATA2 light blue Second hard drive

SATA3 orange Second optical drive
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Drives
The computer supports up to five drives that may be installed in various configurations.

This section describes the procedure for replacing or upgrading the storage drives. A Torx T-15
screwdriver is needed to remove and install the guide screws on a drive.

Drive Positions
Figure 6-14  Drive Positions

NOTE: HP Pro 3010 shown.

1 Two 5.25-inch external drive bays for optional drives (optical drives shown)

2 One 3.5-inch external drive bay for optional drive (media card reader shown)

3 Primary 3.5-inch internal hard drive bay

4 Secondary 3.5-inch internal hard drive bay for optional hard drive

To verify the type, size, and capacity of the storage devices installed in the computer, run Computer
Setup. Refer to the Computer Setup (F10) Utility Guide for more information.
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Installing Additional Drives
When installing additional drives, follow these guidelines:

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA0
connector on the system board.

● Connect the first SATA optical drive to the white SATA1 connector on the system board.

● Always populate the dark blue and white connectors before the light blue and orange
connectors.

● The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

● If needed, HP has provided extra drive retainer screws on the interior of the front bezel that are
used to secure the drives in the drive cage. Hard drives use 6-32 standard screws. All other
drives use M3 metric screws. The HP-supplied M3 metric guide screws (1) are black. The HP-
supplied 6-32 standard screws (2) are silver.

Figure 6-15  Extra Drive Retainer Screws Location

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”
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System Board Drive Connections
Refer to the following illustration and table to identify the system board drive connectors.

Figure 6-16  System Board Drive Connections – HP Pro 3000/3080
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Figure 6-17  System Board Drive Connections – HP Pro 3010

Table 6-4  System Board Drive Connectors

No. System Board
Connector

System Board Label –
HP Pro 3000/3080

Color System Board Label –
HP Pro 3010

Color

1 SATA1 SATA1 dark blue SATA0 dark blue

2 SATA2 SATA2 white SATA1 white

3 SATA3 SATA3 light blue SATA2 light blue

4 SATA4 SATA4 orange SATA3 orange

5 Media Card Reader MEDIA black F_USB2 white
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Removing an Optical Drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

To remove an optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Remove the front bezel (Front Bezel on page 37).

4. Disconnect the power cable (1) and data cable (2) from the rear of the optical drive.

Figure 6-18  Disconnecting the Power and Data Cables

5. Remove the two screws that secure the drive to the drive cage (1), then slide the drive out of the
front of the chassis (2).

Figure 6-19  Removing the Optical Drive
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NOTE: To install an optical drive, refer to Installing an Optical Drive into the 5.25-inch Drive Bay
on page 57.

Installing an Optical Drive into the 5.25-inch Drive Bay
To install an optional 5.25-inch optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Remove the front bezel (Front Bezel on page 37).

4. If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank.

5. If you are adding a drive to an empty lower optical drive bay, you must remove the knockout
plate from the bay. To do so, insert a flat screwdriver into the knockout plate slot and rotate the
screwdriver to break the knockout plate out of the chassis. Discard the knockout plate.

6. If the new drive has screws installed on the sides of the drive, remove the screws before
inserting the drive into the chassis.

7. Slide the drive in through the front of the chassis (1) until the screw holes on the drive are
aligned with the screw holes on the drive cage and install the two M3 metric retainer screws (2)
as shown in the following illustration.

NOTE: Extra drive retainer screws are provided on the interior of the front bezel if needed. The
M3 metric retainer screws for optical drives are black.

Figure 6-20  Installing the Optical Drive

8. If the system configuration includes only one optical drive, connect the SATA data cable to the
white system board connector labeled SATA2. If you are adding a second optical drive, connect
the SATA data cable to the orange system board connector labeled SATA4.
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9. Connect the power cable (1) and data cable (2) to the rear of the optical drive.

Figure 6-21  Connecting the Power and Data Cables

10. Replace the front bezel and access panel.

11. Reconnect the power cord and turn on the computer.

12. Lock any security devices that were disengaged when the access panel was removed.

The system automatically recognizes the drive and reconfigures the computer.

Removing an External 3.5-inch Drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

NOTE: The 3.5-inch drive bay may contain a media card reader.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Remove the front bezel (Front Bezel on page 37).

4. Disconnect the drive cables.

a. If you are removing a diskette drive (available on some models only), disconnect the data
cable and power cable from the back of the drive.

b. If you are removing a media card reader, disconnect the USB cable from the system board.
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5. Remove the two retainer screws that secure the drive to the bay (1) then slide the drive forward
and out of the bay (2).

Figure 6-22  Removing a 3.5-inch Device (Media Card Reader Shown)

Installing a Drive into the 3.5-inch External Drive Bay
The 3.5-inch external drive bay on the front of the computer can be configured with a media card
reader.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Remove the front bezel (Front Bezel on page 37).

4. If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank.

5. If you are adding a drive to an empty drive bay for the first time, you must remove the knockout
plate from the bay. To do so, insert a flat screwdriver into the knockout plate slot and rotate the
screwdriver to break the knockout plate out of the chassis. Discard the knockout plate.

6. If the new drive has screws installed on the sides of the drive, remove them before inserting the
drive into the chassis.
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7. Slide the drive in through the front of the chassis (1) until the bezel on the drive is evenly aligned
with the computer front bezel and install the two M3 metric retainer screws (2) as shown in the
illustration below.

NOTE: Extra drive retainer screws are provided on the interior of the front bezel if needed. The
M3 metric retainer screws for diskette drives or media card readers are black.

Figure 6-23  Installing a 3.5-inch Device (Media Card Reader Shown)

8. Connect the appropriate drive cables:

a. If installing a diskette drive (available on some models only), connect the power and data
cables to the rear of the drive and connect the other end of the data cable to the connector
on the system board.

b. If installing a media card reader, connect the USB cable from the media card reader to the
USB connector on the system board.

9. Replace the front bezel and access panel.

10. Reconnect the power cord and turn on the computer.

11. Lock any security devices that were disengaged when the access panel was removed.

Removing an Internal 3.5-inch Hard Drive
NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive,
make sure you have created a Recovery Disc Set to restore the operating system, software drivers,
and any software applications that were preinstalled on the computer. If you do not have this CD set,
select Start > HP Backup and Recovery and create it now.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).
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3. Remove the two screws that secure the hard drive cage to the chassis.

Figure 6-24  Removing the Hard Drive Cage Screws

4. Push down the latch on the side of the hard drive cage (1), then slide the hard drive cage away
from the bottom of the chassis (2) as shown below.

Figure 6-25  Releasing the Hard Drive Cage
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5. Lift the hard drive cage out of the chassis.

Figure 6-26  Removing the Hard Drive Cage

6. Disconnect the power cable (1) and data cable (2) from the back of the hard drive.

Figure 6-27  Disconnecting the Hard Drive Cables

62 Chapter 6   Removal and Replacement Procedures Microtower (MT) Chassis



7. Remove the four screws that secure the hard disk drive to the hard drive cage (1), then slide the
hard disk drive out of the hard drive cage (2).

Figure 6-28  Removing the Hard Drive

NOTE: To install an internal 3.5-inch hard drive, refer to Installing an Internal 3.5-inch Hard Drive
on page 64.
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Installing an Internal 3.5-inch Hard Drive
1. Follow the steps in Removing an Internal 3.5-inch Hard Drive on page 60 to remove the hard

drive cage and, if necessary, the existing hard drive.

2. Slide the new drive into the hard disk drive cage (1), aligning the drive with the four screw holes
on the cage. Install the four 6-32 standard screws that secure the hard disk drive to the hard disk
drive cage (2). Make sure the hard disk drive cables are facing the top of the drive cage.

NOTE: If you are replacing an old drive with a new drive, use the four retainer screws from the
old drive to install the new drive.

NOTE: If you are installing a second hard drive, use four of the extra standard 6-32 screws that
are installed on the interior of the front bezel. The 6-32 screws are silver.

Figure 6-29  Installing the Hard Drive in the Drive Cage
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3. Connect the power cable (1) and data cable (2) to the back of the hard drive.

Figure 6-30  Connecting the Hard Drive Cables

CAUTION: Never crease or bend a SATA data cable tighter than a 30 mm (1.18 in) radius. A
sharp bend can break the internal wires.

4. Place the hard disk drive cage into the chassis (1), then slide it down toward the bottom of the
chassis until it locks into place (2).

Figure 6-31  Installing the Hard Drive Cage
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5. Attach the two screws that secure the hard disk drive cage to the chassis.

Figure 6-32  Securing the Hard Drive Cage

6. If installing a new drive, connect the opposite end of the data cable to the appropriate system
board connector. If your system has only one SATA hard drive, you must connect the hard drive
data cable to the dark blue connector to avoid any hard drive performance problems. If you are
adding a second hard drive, connect the data cable to the next available (unpopulated) SATA
connector on the system board.

NOTE: If your system has only one SATA hard drive, you must connect the hard drive data
cable to the dark blue SATA on the system board to avoid any hard drive performance problems.
If you are adding a second hard drive, connect the data cable to the next available (unpopulated)
SATA connector on the system board.

7. Replace the computer access panel.

8. Reconnect the power cord and any external devices, then turn on the computer.

9. Lock any security devices that were disengaged when the access panel was removed.
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Front I/O and USB Panel Housing Assembly
1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36)

3. Lay the computer on its side with the front facing toward you.

4. Remove the front bezel (Front Bezel on page 37).

5. Unplug the four cables that connect the assembly to the system board. The assembly cables
connect to the following system board connectors:

● F_AUDIO– yellow

● F_USB1 – white

6. Remove the screw (1) that secures the housing to the chassis, slide the housing up (2), and then
pull the assembly away from the chassis while guiding the cables through the hole in the
chassis.

To install the housing assembly, reverse the removal procedures.
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Power Switch/LED Assembly
1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Lay the computer on its side with the front facing toward you.

4. Remove the front bezel (Front Bezel on page 37).

5. Remove the optical drive (Removing an External 3.5-inch Drive on page 58).

6. Disconnect the braided cables from the black system board connector labeled F_PANEL.

7. Remove the cable from the clips in the optical drive cage.

8. Press the tab on the top of the switch holder (1) to disengage it from the chassis, lift the switch
upward to disengage the tab at the bottom of the switch (2) from the chassis, and then pull the
power switch away from the chassis while guiding the wires through the hole in the chassis.

To install the power switch/LED assembly, reverse the removal procedures.
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System Fan
1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Lay the computer on its side with the rear facing toward you.

4. Disconnect the cable from the red/brown system board connector labeled CHASSIS_FAN1.

5. Remove the four Phillips screws that secure the fan to the chassis, rotate the top of the fan
forward, and then remove the fan from the chassis.

NOTE: HP Pro 3010 shown.

To install the fan, reverse the removal procedures.
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Heat sink assembly
1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Lay the computer on its side with the rear facing toward you.

4. Disconnect the heat sink fan control cable (1) from the white system board connector labeled
CPU_FAN.

5. Loosen the four captive screws (2) that secure the heat sink to the system board.

6. Lift the heat sink from the processor and set it on its side to keep from contaminating the work
area with thermal grease.

NOTE: HP Pro 3010 shown.

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heat sink to the processor. This is especially important as the pins on the socket
are very fragile and any damage to them may require replacing the system board.

When reinstalling an existing heat sink, make sure that its bottom has been cleaned with an alcohol
wipe and fresh thermal grease has been applied to the top of the processor. New heatsinks come
from the factory with fresh thermal grease already applied.
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Processor
1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Lay the computer on its side with the rear facing toward you.

4. Disconnect the heatsink control cable from the system board and remove the heatsink Heat sink
assembly on page 70).

5. Rotate the locking lever to its full open position (1).

6. Raise and rotate the microprocessor retainer to its full open position (2)

7. Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

CAUTION: The heat sink must be installed within 24 hours of installing the processor to
prevent damage to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heat sink, go to step 3.

If using a new heat sink, go to step 6.

3. If reusing the existing heat sink, clean the bottom of the heat sink with the alcohol pad provided
in the spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the
heat sink atop the processor.
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5. Go to step 7.

6. If using a new heat sink, remove the protective covering from the bottom of the heat sink and
place it in position atop the processor.

7. Secure the heat sink to the system board and system board tray with the 4 captive screws and
attach the heat sink control cable to the system board.

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

NOTE: After installing a new processor onto the system board, always update the system
ROM to ensure that the latest version of the BIOS is being used on the computer. The latest
system ROM BIOS can be found on the Web at: http:\\h18000.www1.hp.com/support/files.

Power Supply
WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

NOTE: When installing a new power supply, be sure to set the red switch to the setting (230 V or
115 V) appropriate for the country in which the computer is used. Spare power supplies normally
arrive set for 230 V.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Lay the computer on its side with the rear facing toward you.

4. Disconnect all power cables from the mass storage devices and from the system board.

5. Remove the four screws that secure the power supply to the chassis.

NOTE: HP Pro 3010 shown.
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6. Inside of the unit, press the power supply release latch on the chassis base, and then lift up the
rear of the power supply to disengage it from the chassis.

7. Slide the power supply toward the front/bottom of the computer, then lift the power supply out of
the computer.

To install the power supply, reverse the removal procedure.
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System Board
When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● Memory modules

● Processor

● Expansion cards

To remove the system board:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

3. Lay the computer on its side with the rear facing toward you.

4. Remove the front bezel (Front Bezel on page 37).

5. Remove an expansion cards (Expansion Cards on page 44).

6. Disconnect the power, and data cables from the back of all installed drives.

7. Disconnect all cables from the system board.
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8. Remove the eight screws that secure the system board to the chassis.

NOTE: HP Pro 3010 shown. System board appearance varies by model.

9. Slide the system board toward the front of the chassis, and then lift it up and out of the chassis.

NOTE: The system board in the computer may look slightly different from the one shown here.

To install the system board, reverse the removal procedure.

NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

NOTE: After installing a new system board, always update the system ROM to ensure that the
latest version of the BIOS is being used on the computer. The latest system ROM BIOS can be found
at: http:\\h18000.www1.hp.com/support/files.

Battery
The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.
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WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

❑ Do not attempt to recharge the battery.

❑ Do not expose to temperatures higher than 60°C (140°F)

❑ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

❑ Replace the battery only with the HP/Compaq spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to the
Troubleshooting Guide for information on backing up the CMOS settings.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, its authorized partners, or its agents.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 35).

2. Remove the access panel (Access Panel on page 36).

NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge of

the battery. When the battery pops up, lift it out (1).

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.

Type 3 Battery Holder
1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).
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2. Insert the new battery and position the clip back in place.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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Installing a Security Lock
The security locks displayed below and on the following pages can be used to secure the computer.

HP/Kensington MicroSaver Security Cable Lock
Figure 6-33  Installing a Cable Lock

Padlock
Figure 6-34  Installing a Padlock
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HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 6-35  Securing the Cable to a Fixed Object

2. Thread the keyboard and mouse cables through the lock.

Figure 6-36  Threading the Keyboard and Mouse Cables
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3. Screw the lock to the chassis using the screw provided.

Figure 6-37  Attaching the Lock to the Chassis

4. Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 6-38  Engaging the Lock
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Hood Sensor
If the access panel is removed while there is still power to the computer, the hood sensor will cause
the system to stop and display the Error 912 message after system reboot and will beep 5 times for 5
seconds. If the alarm sounds, close the access panel, tighten the thumbscrew, then reboot the
system. The system will enter the operating system successfully. If the error message persists, press
the F10 key immediately when the HP Logo screen is displayed to enter the Computer Setup menu.
In the menu, select Advanced > Hood Sensor > Reset Case Open Status and make sure Enable
is selected, then press the F10 key to Save and Exit, then reboot the system.
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HP Chassis Security Kit
An optional HP Chassis Security Kit prevents computer components from being removed through an
open optical drive bay.

Figure 6-39  HP Chassis Security Kit

Figure 6-40  Installing the HP Chassis Security Kit
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7 Removal and Replacement Procedures
Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly
1. Close any open software applications.

2. Exit the operating system.

3. Remove any diskette or compact disc from the computer.

4. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

5. Disconnect the power cord from the electrical outlet and then from the computer.

6. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.
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Access Panel
1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the thumbscrews that secure the access panel to the computer chassis (1).

3. Slide the access panel back about 1.3 cm (1/2 inch), then lift it away from and off the unit (2).

Figure 7-1  Removing the Access Panel

To install the access panel, reverse the removal procedure.

Access Panel 85



Front Bezel
1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. To remove the front bezel, pull up on each of the three tabs on the top of the bezel (1) to release
them, then rotate the bezel down and off the chassis (2).

Figure 7-2  Removing the Front Bezel

To install the front bezel, reverse the removal procedure.
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Bezel Blanks
1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. While facing the inside of the front bezel, press the two retaining tabs on the right towards the
outer edge of the bezel (1) and pull the bezel blank inwards to remove it (2).

Figure 7-3  Removing a Bezel Blank
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Memory
The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 8 GB of memory.

DDR3-SDRAM DIMMs
For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-10600 DDR3-1333 MHz-compliant

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 9 DDR3 1333 MHz (9-9-9 timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets
There are four DIMM sockets on the system board, with two sockets per channel.

Populate the DIMM sockets in the following order: DIMM1, DIMM3, DIMM2, then DIMM4.
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Figure 7-4  DIMM Socket Locations – HP Pro 3010

Table 7-1  DIMM Socket Locations

Item Description Socket Color (HP Pro 3000/3080) Socket Color
(HP Pro 3010)

Insertion Order

1 XMM1 socket, Channel A (populate
first)

White Blue 1

2 XMM2 socket, Channel B Black Black 3

3 XMM3 socket, Channel A (populate
second)

White Blue 2

4 XMM4 socket, Channel B Black Black 4

NOTE: A DIMM must occupy the XMM1/DIMM1 socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

● The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B.
The technology and device width can vary between the channels. For example, if Channel A is
populated with two 1-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

● The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel
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populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. For optimal speed, the channels
should be balanced so that the largest amount of memory is spread between the two channels.
If one channel will have more memory than the other, the larger amount should be assigned to
Channel A. For example, if you are populating the sockets with one 2-GB DIMM, and three 1-GB
DIMMs, Channel A should be populated with the 2-GB DIMM and one 1-GB DIMM, and Channel
B should be populated with the two 1-GB DIMMs. With this configuration, 4-GB will run as dual
channel and 1 GB will run as single channel.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs
CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Rotate the drive cage all the way up.

Figure 7-5  Rotating the Drive Cage Up
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4. Locate the memory module sockets on the system board.

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.

5. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

NOTE: Populate the DIMM sockets in the following order: DIMM1, DIMM3, DIMM2, then
DIMM4.

Figure 7-6  Installing a DIMM

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

A DIMM must occupy the XMM1 socket. Always populate the white sockets before the black
sockets in each channel.

In order to create a dual-channel memory configuration, the memory capacity of Channel A must
equal the memory capacity of Channel B.

6. Push the DIMM module down firmly into the socket, ensuring that the module is fully inserted
and properly seated. The DIMM must be pushed all the way down into the socket and sit evenly
in the socket to avoid memory corruption. Make sure the latches are in the closed position (3).

7. Repeat steps 5 and 6 to install any additional modules.
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8. Push in the latch holding the drive cage upright (1) and lower the drive cage all the way down
(2).

Figure 7-7  Lowering the Drive Cage

9. Replace the computer access panel.

10. Reconnect the power cord and any external devices, then turn on the computer. The computer
should automatically recognize the additional memory when you turn on the computer.

11. Lock any security devices that were disengaged when the access panel was removed.
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Removing or Installing an Expansion Card
The HP Pro 3000 and HP Pro 3080 has two PCI slots, one PCI Express x1 expansion slots, and one
PCI Express x16 expansion slot. The expansion slots accommodate full-height or half-height
expansion cards.

Figure 7-8  Expansion Slot Locations – HP Pro 3000/3080

Table 7-2  Expansion Slot Locations – HP Pro 3000/3080

Item Description

1 PCI expansion slot

2 PCI expansion slot

3 PCI Express x1 expansion slot

4 PCI Express x16 expansion slot

The HP Pro 3010 has three PCI Express x1 expansion slots and one PCI Express x16 expansion
slot. The expansion slots accommodate full-height or half-height expansion cards.
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Figure 7-9  Expansion Slot Locations – HP Pro 3010

Table 7-3  Expansion Slot Locations – HP Pro 3010

Item Description

1 PCI Express x1 expansion slot

2 PCI Express x1 expansion slot

3 PCI Express x1 expansion slot

4 PCI Express x16 expansion slot

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16
expansion slot.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).
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3. On the rear panel of the computer, lift the slot cover latch (1) and rotate slot cover up and away
from the slots (2).

Figure 7-10  Releasing the Slot Cover Lock

4. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

a. If you are installing an expansion card in a vacant socket, you must use a flat-blade
screwdriver to pry out the metal shield on the rear panel that covers the expansion slot. Be
sure to remove the appropriate shield for the expansion card you are installing.

Figure 7-11  Removing an Expansion Slot Cover
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b. If you are removing a PCI or PCI Express x1 card, hold the card at each end and carefully
rock it back and forth until the connectors pull free from the socket. Be sure not to scrape
the card against the other components.

Figure 7-12  Removing a PCI or PCI Express x1 Expansion Card

c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Be sure not to scrape the card against the other
components.

Figure 7-13  Removing a PCI Express x16 Expansion Card

5. Store the removed card in anti-static packaging.

6. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.
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CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.

7. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis so that the bottom of the bracket on the
card slides into the small slot on the chassis. Press the card straight down into the expansion
socket on the system board.

Figure 7-14  Installing an Expansion Card

NOTE: When installing an expansion card, press firmly on the card so that the whole
connector seats properly in the expansion card slot.

8. While holding the expansion card bracket against the chassis, rotate the slot cover lock over the
expansion card brackets and slot covers. Push the slot cover lock down to latch it and secure
the card brackets.

Figure 7-15  Closing the Slot Cover Lock
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9. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

10. Replace the computer access panel.

11. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide for
instructions on using Computer Setup.

Cable Management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heatsink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cable from the connector on the system board, always follow
these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.
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Cable Connections

HP Pro 3000/3080
System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

PWR white Power supply, 24-pin

PWRCPU white Power supply, 4-pin

CHFAN1 maroon Chassis fan

CPUFAN white Heat sink fan

FRNT AUDIO yellow Front I/O audio

FRNT USB1 white Front I/O USB

JFP1 black Power button

FRNT USB2 white Media card reader

SATA1 dark blue Primary hard drive

SATA2 white Primary optical drive

SATA3 light blue Second hard drive

SATA4 orange Second optical drive

SPKR white Speaker

MEDIA black Media card reader

HP Pro 3010
System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

Not labeled white Power supply, 24-pin

ATX_CPU white Power supply, 4-pin

CHASSIS_FAN1 maroon Chassis fan

CPU_FAN white Heat sink fan

J_AUDIO yellow Front I/O audio

J_USB1 white Front I/O USB

F_PANEL black Power button

JUSB2 white Media card reader

SATA0 dark blue Primary hard drive

SATA1 white Primary optical drive
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Connector Name Connector Color Description

SATA2 light blue Second hard drive

SATA3 orange Second optical drive

Drives
A Torx T-15 screwdriver is needed to remove and install the guide screws on a drive.

Drive Positions
NOTE: Your computer model may look different than the model shown below. Diskette drives are
only available on some models.

Figure 7-16  Drive Positions

1 3.5-inch external drive bay for optional drive (diskette drive shown)

2 3.5-inch internal hard drive bay

3 5.25-inch external drive bay for optional drive (optical drive shown)

To verify the type, size, and capacity of the storage devices installed in the computer, run Computer
Setup. Refer to the Computer Setup (F10) Utility Guide for more information.
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Installing Additional Drives
When installing additional drives, follow these guidelines:

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA1.

● Connect the SATA optical drive to the white SATA connector on the system board labeled
SATA2.

● The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

● If needed, HP has provided extra drive retainer screws on the front of the chassis under the hard
drive cage. Hard drives use 6-32 standard screws. All other drives use M3 metric screws. The
HP-supplied M3 metric guide screws (1) are black. The HP-supplied 6-32 standard screws (1)
are silver.

Figure 7-17  Extra Drive Retainer Screws Location

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”
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System Board Drive Connectors
Refer to the following illustration and table to identify the system board drive connectors.

Figure 7-18  System Board Drive Connectors – HP Pro 3000/3080
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Figure 7-19  System Board Drive Connectors – HP Pro 3010

Table 7-4  System Board Drive Connectors

No. System Board
Connector

System Board Label –
HP Pro 3000/3080

Color System Board Label –
HP Pro 3010

Color

1 SATA1 SATA1 dark blue SATA0 dark blue

2 SATA2 SATA2 white SATA1 white

3 SATA3 SATA3 light blue SATA2 light blue

4 SATA4 SATA4 orange SATA3 orange

5 Media Card Reader MEDIA black F_USB2 white
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Removing an Optical Drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

To remove an optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. Disconnect the power cable (1) and data cable (2) from the rear of the optical drive.

Figure 7-20  Disconnecting the Power and Data Cables

5. Rotate the drive cage all the way up.

Figure 7-21  Rotating the Drive Cage Up
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6. Remove the two retainer screws that secure the drive to the bay (1) then slide the drive forward
and out of the bay (2).

Figure 7-22  Removing a 5.25-inch External Drive

Installing an Optical Drive into the 5.25-inch Drive Bay
To install an optional 5.25-inch optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank.

5. Install the guide screw in the front top hole on the left side of the drive.

Figure 7-23  Installing the Guide Screw in the Optical Drive
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6. Rotate the drive cage all the way up.

Figure 7-24  Rotating the Drive Cage Up

7. Align the guide screw on the drive with the slot on the chassis. Slide the optical drive into the
drive bay until the two screw holes on the right side of the drive line up with the two screw holes
on the right side of the drive cage (1).

8. Secure the optical drive by fastening two retainer screws through the holes in the right side of
the drive cage into the corresponding holes in the right side of the optical drive (2).

NOTE: Extra retainer screws are provided on the front of the chassis under the hard drive
cage. The M3 metric retainer screws for optical drives are black.

Figure 7-25  Installing the Optical Drive
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9. Push in the latch holding the drive cage upright (1) and lower the drive cage all the way down
(2).

Figure 7-26  Lowering the Drive Cage

10. Connect the SATA data cable to the white system board connector.

11. Connect the power cable (1) and data cable (2) to the rear of the optical drive.

Figure 7-27  Connecting the Power and Data Cables

12. Replace the front bezel and access panel.

13. Reconnect the power cord and turn on the computer.

14. Lock any security devices that were disengaged when the access panel was removed.

The system automatically recognizes the drive and reconfigures the computer.

Removing an External 3.5-inch Drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
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NOTE: The 3.5-inch drive bay may contain a diskette drive or a media card reader.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. Disconnect the drive cables.

a. If you are removing a diskette drive (available on some models only), disconnect the data
cable and power cable from the back of the drive.

b. If you are removing a media card reader, disconnect the USB cable from the system board.

5. Rotate the drive cage all the way up.

Figure 7-28  Rotating the Drive Cage Up
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6. Remove the two retainer screws that secure the drive to the bay (1) then slide the drive forward
and out of the bay (2).

Figure 7-29  Removing a 3.5” Device (Diskette Drive Shown)

Installing a Drive into the 3.5-inch External Drive Bay
The 3.5-inch external drive bay on the front of the computer can be configured with a media card
reader or a diskette drive.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank.

5. If you are adding a drive to an empty drive bay for the first time, you must remove the knockout
plate from the bay. To do so, insert a flat screwdriver into the knockout plate slot and rotate the
screwdriver to break the knockout plate out of the chassis. Discard the knockout plate.

6. If the new drive has screws installed on the sides of the drive, remove them before inserting the
drive into the chassis.
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7. Rotate the drive cage all the way up.

Figure 7-30  Rotating the Drive Cage Up

8. Slide the drive into the drive bay (1) until the two screw holes on the left side of the drive line up
with the two screw holes on the left side of the drive cage. Secure drive by fastening two retainer
screws through the holes in the left side of the drive cage into the corresponding holes in the left
side of the drive (2).

Figure 7-31  Installing a 3.5-inch Device (Diskette Drive Shown)

NOTE: The drive cage screw holes for each type of drive are labeled “CR” for media card
reader or “FDD” for diskette drive.

Extra retainer screws are provided on the front of the chassis under the hard drive cage. The M3
metric retainer screws for diskette drives or media card readers are black.
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9. Push in the latch holding the drive cage upright (1) and lower the drive cage all the way down
(2).

Figure 7-32  Lowering the Drive Cage

10. Connect the appropriate drive cables:

a. If installing a diskette drive (available on some models only), connect the power and data
cables to the rear of the drive and connect the other end of the data cable to the connector
on the system board.

b. If installing a media card reader, connect the USB cable from the media card reader to the
USB connector on the system board.

11. Replace the front bezel and access panel.

12. Reconnect the power cord and turn on the computer.

13. Lock any security devices that were disengaged when the access panel was removed.
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Removing an Internal 3.5-inch Hard Drive
NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive,
make sure you have created a Recovery Disc Set to restore the operating system, software drivers,
and any software applications that were preinstalled on the computer. If you do not have this CD set,
select Start > HP Backup and Recovery and create it now.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. Disconnect the power cable (1) and data cable (2) from the back of the hard drive.

Figure 7-33  Disconnecting the Hard Drive Cables
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5. Rotate the drive cage all the way up.

Figure 7-34  Rotating the Drive Cage Up

6. Remove the two retainer screws that secure the drive to the bay (1) then slide the drive back
and out of the bay (2).

Figure 7-35  Removing an Internal Hard Drive
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Installing an Internal 3.5-inch Hard Drive
1. Follow the steps in Removing an Internal 3.5-inch Hard Drive on page 113 to remove the old

hard drive.

2. Install the guide screw in the middle hole on the right side of the drive.

NOTE: When replacing a hard drive, remove the guide screws from the old drive for use with
the new drive.

Figure 7-36  Installing the Guide Screw in the Hard Drive

3. Align the guide screw on the drive with the slot on the chassis. Slide the hard drive into the drive
bay from the back until the two screw holes on the left side of the drive line up with the two
screw holes on the left side of the drive cage (1).

4. Secure the hard drive by fastening two retainer screws through the holes in the left side of the
drive cage into the corresponding holes in the left side of the hard drive (2).

Figure 7-37  Installing an Internal Hard Drive

NOTE: Extra retainer screws are provided on the front of the chassis under the hard drive
cage. The 6-32 retainer screws for hard drives are silver.
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5. Push in the latch holding the drive cage upright and lower the drive cage all the way down.

Figure 7-38  Lowering the Drive Cage

6. Connect the power cable (1) and data cable (2) to the back of the hard drive.

Figure 7-39  Connecting the Hard Drive Cables

CAUTION: Never crease or bend a SATA data cable tighter than a 30 mm (1.18 in) radius. A
sharp bend can break the internal wires.

7. Replace the access panel and front bezel.

8. Reconnect the power cord and any external devices, then turn on the computer.

9. Lock any security devices that were disengaged when the access panel was removed.

NOTE: If you are replacing the primary hard drive, use the Recovery Disc Set to restore the
operating system, software drivers, and any software applications that were preinstalled on the
computer.
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Plastic Wire/Cable Fastener and Clips
Three different plastic wire fasteners (illustrated below) secure many of the system wires. You have to
loosen these fasteners to gain access to the wires for several computer components. See the
following illustration for proper routing of wires.

NOTE: HP Pro 3015 shown. System board appearance varies by model.

To loosen the fasteners:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Rotate the drive cage to its upright position.

4. To open the round fastener (1), twist the two ends of the fastener until the ends come apart.
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5. To open the square fastener (2), at the notch where the fastener latch connects, pull the top of
the fastener up and outward.

6. To open the fastener mounted under the hard drive (3), pull the latch on the right side of the
fastener directly downward.

To close the fasteners, reverse the loosening procedure.
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Front I/O Device
1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. Rotate the drive cage to its upright position.

5. Unplug the audio cable from the yellow system board connector labeled F_AUDIO.

6. Unplug the USB cable from the white system board connector labeled F_USB1.

7. Rotate the drive cage back down.

8. Remove the screw that secures the front I/O device to the chassis (1).

9. Rotate the assembly toward the right side of the chassis, and then slide the device slightly
toward the left (2) to disengage the tab on the right side of the assembly from the chassis.
Thread the wires through the hole in the chassis and remove the assembly.

NOTE: If necessary, rotate the drive cage back up to better access the hole you thread the
cables through.

To install the front I/O device, reverse the removal procedures.
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Power Switch Assembly
1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. Rotate the drive cage to its upright position.

5. Disconnect the power switch wires from the black system board connector labeled F_PANEL.

6. Rotate the drive cage back down.

7. Press the tab on the bottom of the assembly (1) to disengage it from the chassis.

8. Slide the assembly downward (2) to disengage the tab on the top of assembly from the chassis.

9. If necessary, rotate the drive cage back up to gain access to the wires.

10. Pull the assembly out through front of unit while threading the wires through the hole in the
chassis.

To install the power switch assembly, reverse the removal procedure.
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Heatsink
1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Unplug the fan wire from the white system board connector labeled CPU FAN (1).

4. Loosen the four captive screws (2) that secure the heatsink to the system board tray.

CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an
X) to even the downward forces on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

NOTE: HP Pro 3015 shown. System board appearance varies by model.

5. Lift the heatsink from atop the processor and set it on its side to keep from contaminating the
work area with thermal grease.

When reinstalling the heatsink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heatsink on the processor. This is especially important as the pins on the socket
are very fragile and any damage to them may require replacing the system board.
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Processor
1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the heatsink (Heatsink on page 121).

4. Raise the locking lever to its fully open position (1).

5. Raise and rotate the microprocessor retainer to its fully open position (2).

6. Carefully lift the processor from the socket (3) labeled PROCESSOR.

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heatsink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever. If reusing the existing heatsink, go to step 3. If using a new heatsink,
go to step 6.

3. If reusing the existing heatsink, clean the bottom of the heatsink with the alcohol pad provided in
the spares kit.

CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the
bottom of the heatsink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the
spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the
heatsink atop the processor.
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5. Go to step 7.

6. If using a new heatsink, remove the protective covering from the bottom of the heatsink and
place it in position atop the processor.

7. Secure the heatsink to the system board and system board tray with the four captive screws and
attach the heatsink control cable to the system board.

CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the heatsink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Power Supply
1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. Rotate the drive cage to its upright position.

5. Open the plastic cable fasteners so you can remove the wires from them (Plastic Wire/Cable
Fastener and Clips on page 117).

6. Unplug all power supply wires from the system board and the drives, noting their locations for
reinstallation.

7. Remove the three screws that secure the power supply to the back of the chassis.

NOTE: HP Pro 3015 shown. System rear panel appearance varies by model.
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8. Remove the screw that secures the power supply to the base of the computer.

NOTE: HP Pro 3015 shown. System board appearance varies by model.

9. Slide the power supply about 1.25 cm (1/2-inch) toward the front of the chassis, rotate the power
supply toward the heatsink so it clears the lip at the top of the chassis, and then lift the power
supply out of the chassis.

To install the power supply, reverse the removal procedure.
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System Board
1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the access panel (Access Panel on page 85).

3. Remove the front bezel (Front Bezel on page 86).

4. Loosen the plastic cable fasteners (Plastic Wire/Cable Fastener and Clips on page 117).

5. Remove all PCI and PCI Express expansion boards (Removing or Installing an Expansion Card
on page 94).

6. Remove all memory modules (Memory on page 88).

7. Disconnect all data and power cables from the system board.

8. Remove the heatsink (Heatsink on page 121).

9. Remove the power supply (Power Supply on page 123).

10. Remove the eight screws that secure the system board to the chassis, slide the board about
1.25 cm (1/2 inch) toward the front of the chassis, and then lift the board out of the chassis.

NOTE: HP Pro 3015 shown. System board appearance varies by model.

To install the system board, reverse the removal procedure.
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CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom
of the heatsink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply
thermal grease to the top of the processor from the syringe supplied in the spares kit.

CAUTION: When reconnecting the cables it is important that they be positioned so they do not
interfere with the rotation of the drive cage or power supply.

NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

Battery
The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer
Setup (F10) Utility Guide for information on backing up the CMOS settings.

NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 84).

2. Remove the computer access panel (Access Panel on page 85).

NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Carefully pull the cable bundle out of the way to access the battery.

5. Depending on the type of battery holder on your system board, complete the following
instructions to replace the battery:
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Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.

Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge of

the battery. When the battery pops up, lift it out (1).

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

3. Replace the computer access panel.
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4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.

Type 3 Battery Holder
1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).

2. Insert the new battery and position the clip back in place.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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Installing a Security Lock
The security locks displayed below and on the following pages can be used to secure the computer.

HP/Kensington MicroSaver Security Cable Lock
Figure 7-40  Installing a Cable Lock

Padlock
Figure 7-41  Installing a Padlock
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HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 7-42  Securing the Cable to a Fixed Object

2. Thread the keyboard and mouse cables through the lock.

Figure 7-43  Threading the Keyboard and Mouse Cables
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3. Remove the left screw that secures the computer access panel to the chassis and screw the
lock to the chassis using the screw provided.

Figure 7-44  Attaching the Lock to the Chassis

4. Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 7-45  Engaging the Lock
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Hood Sensor
If the access panel is removed while there is still power to the computer, the hood sensor will cause
the system to stop and display the Error 912 message after system reboot and will beep 5 times for 5
seconds. If the alarm sounds, close the access panel, tighten the thumbscrew, then reboot the
system. The system will enter the operating system successfully. If the error message persists, press
the F10 key immediately when the HP Logo screen is displayed to enter the Computer Setup menu.
In the menu, select Advanced > Hood Sensor > Reset Case Open Status and make sure Enable
is selected, then press the F10 key to Save and Exit, then reboot the system.
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HP Chassis Security Kit
An optional HP Chassis Security Kit prevents computer components from being removed through an
open optical drive bay.

Figure 7-46  HP Chassis Security Kit

Figure 7-47  Installing the HP Chassis Security Kit
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A Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. Some of
these connectors may not be used on the product being serviced.

Ethernet BNC
Connector and Icon Pin Signal

1

2

Data

Ground

USB
Connector and Icon Pin Signal

1

2

3

4

+5 VDC

- Data

+ Data

Ground

Microphone
Connector and Icon (1/8” miniphone) Pin Signal

1 2 3
1 (Tip)

2 (Ring)

3 (Shield)

Audio_left

Audio_Right

Ground

134 Appendix A   Connector Pin Assignments



Headphone
Connector and Icon (1/8” miniphone) Pin Signal

1 2 3
1 (Tip)

2 (Ring)

3 (Shield)

Audio_left

Power_Right

Ground

Line-in Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 2 3
1 (Tip)

2 (Ring)

3 (Shield)

Audio_In_Left

Audio_In_Right

Ground

Line-out Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 2 3
1 (Tip)

2 (Ring)

3 (Shield)

Audio_Out_Left

Audio_Out_Right

Ground

4-Pin Power (for CPU)
Connector and Icon Pin Signal

1

2

3

4

GND

GND

+12V CPU

-12V CPU
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Monitor
Connector and Icon

Pin Signal  Pin Signal

1

2

3

4

Red Analog

Green Analog

Blue Analog

Not used

 9

10

11

12

+5V (fused)

Ground

Not used

DDC Serial Data

5

6

7

8

Ground

Ground

Ground

Ground

 13

14

15

Horizontal Sync

Vertical Sync

DDC Serial Clock

24-Pin Power
Connector

24

12

13

1

Front

Pin Signal Pin Signal Pin Signal Pin Signal

1

2

3

4

5

6

+3.3V

+3.3V

GND

+5V

GND

+5V

7

8

9

10

11

12

GND

POK

+5 Vaux

+12V

+12V

+3.3V

13

14

15

16

17

18

+3.3V

–12V

GND

PSON

GND

GND

19

20

21

22

23

24

GND

open

+5V

+5V

+5V

GND
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PCI Express
x1, x4, x8, and x16 PCI Express Connector

Pin A

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1

2

3

4

5

PRSNT1

+12V

+12V

GND

JTAG2

6

7

8

9

10

JTAG3

JTAG4

JTAG5

+3.3V

+3.3V

11

12

13

14

15

PERST#

GND

REFCLK+

REFCLK-

GND

16

17

18

19

20

PERp0

PERn0

GND

RSVD

GND

21

22

23

24

25

PERp1

PERn1

GND

GND

PERp2

26

27

28

29

30

PERn(2)

GND

GND

PERp3

PERn3

31

32

33

34

35

GND

RSVD

RSVD

GND

PERp4

36

37

38

39

40

PERn4

GND

GND

PERp5

PERn5

41

42

43

44

45

GND

GND

PERp6

PERn6

GND

46

47

48

49

50

GND

PERp7

PERn7

GND

RSVD

51

52

53

54

55

GND

PERp8

PERN8

GND

GND

56

57

58

59

60

PERp9

PERn9

GND

GND

PERp10

61

62

63

64

65

PERn10

GND

GND

PERp11

PERn11

66

67

68

69

70

GND

GND

PERp12

PERn12

GND

71

72

73

74

75

GND

PERp13

PERn13

GND

GND

76

77

78

79

80

PERp14

PERn14

GND

GND

PERp15

81

82

PERn15

GND

      

Pin B information is on the next page

NOTE: x1 PCI Express uses pins 1-18

x4 PCI Express uses pins 1-32

x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8
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PCI Express
x1, x4, x8, and x16 PCI Express Connector

Pin B

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1

2

3

4

5

+12V

+12V

RSVD

GND

SMCLK

6

7

8

9

10

SMDAT

GND

+3.3 V

JTAG1

3.3vAux

11

12

13

14

15

WAKE#

RSVD

GND

PETp0

PETn0

16

17

18

19

20

GND

GND

PETp1

PETn1

21

22

23

24

25

GND

GND

PETp2

PETn2

GND

26

27

28

29

30

GND

PETp3

PETn3

GND

RSVD

31

32

33

34

35

PRSNT2#

GND

PETp4

PETn4

GND

36

37

38

39

40

GND

PETp5

PETn5

GND

GND

41

42

43

44

45

PETp6

PRTn6

GND

GND

PETp7

46

47

48

49

50

PETn7

GND

PRSNT2#

GND

PETp8

51

52

53

54

55

PETn8

GND

GND

PETp9

PETn9

56

57

58

59

60

GND

GND

PETp10

PETn10

GND

61

62

63

64

65

GND

PETp11

PETn11

GND

GND

66

67

68

69

70

PETp12

PETn12

GND

GND

PETp13

71

72

73

74

75

PETn13

GND

GND

PETp14

PETn14

76

77

78

79

80

GND

GND

PETp15

PETn15

GND

81

82

PRSNT2#

RSVD

      

Pin B information is on the next page

NOTE: x1 PCI Express uses pins 1-18

x4 PCI Express uses pins 1-32

x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8
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B Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as hard drive,
optical drive, graphics, audio, memory, and software problems. If you encounter problems with the
computer, refer to the tables in this chapter for probable causes and recommended solutions.

Safety and Comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. For more information, refer to the Safety & Regulatory
Information guide.

Before You Call for Technical Support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to the Computer Setup (F10) Utility Guide
for more information.

● Listen for beeps from the computer. The beeps are error codes that will help you diagnose the
problem. Refer to Interpreting POST Audible Codes on page 173 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions
properly.

● If you recently installed new software, uninstall the software and see if the computer functions
properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful Hints on page 142 in this guide.
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To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional
Edition's online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/
go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before
calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized
service provider or dealer.

Helpful Hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

● Check that the computer is turned on and the green power light is on.

● Check that the monitor is turned on and the monitor light is on.

● Listen for beeps from the computer. The beeps are error codes that will help you diagnose the
problem. Refer to Interpreting POST Audible Codes on page 173 for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.

● Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 160 for instructions.
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● Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

● Remove all bootable media (CD or USB device) from the system before turning it on.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the
other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA source in
Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems
You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the
operation, contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table C-1  Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

First, reset the date and time under Control Panel
(Computer Setup can also be used to update the RTC date
and time). If the problem persists, replace the RTC battery.
See the Hardware Reference Guide for instructions on
installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.
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There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3. Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

The Smart Cover FailSafe Key, a device for manually
disabling the Smart Cover Lock, is available from HP. You
will need the FailSafe Key in case of forgotten password,
power loss, or computer malfunction. Order PN 166527-001
for the wrench-style key or PN 166527-002 for the
screwdriver bit key.

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heatsink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.

Table C-1  Solving General Problems (continued)
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Poor performance is experienced.

Cause Solution

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start >
Run (Windows XP) or Start > Accessories > Run
(Windows Vista) and type msconfig. On the Startup
tab of the System Configuration Utility, clear
applications that you do not want to launch
automatically.

Some software applications, especially games, are stressful
on the graphics subsystem

1. Lower the display resolution for the current application
or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

System does not power on.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1. Check that the voltage selector, located on the rear of
the power supply on some models, is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Remove the expansion cards one at a time and see if
the system powers on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2. Open hood and check that the power button harness is
properly connected to the system board.

3. Check that both power supply cables are properly
connected to the system board.

4. Replace the power button harness.

5. Replace the power supply.

6. Replace the system board.

Table C-1  Solving General Problems (continued)
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Solving Power Problems
Common causes and solutions for power problems are listed in the following table.

Table C-2  Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

Voltage selector switch on rear of computer chassis (some
models) not switched to correct line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power
supply fault.

Contact an authorized service provider to replace the power
supply.

Computer powered off automatically.

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heatsink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

3. If fan is plugged in, but is not spinning, then replace the
heatsink/fan assembly.

4. Contact an authorized reseller or service provider.

Power failure (power supply is overloaded). 1. Check that the voltage selector, located on the rear of
the power supply (some models), is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Open the hood and ensure the power supply cable is
seated into the connector on the system board.

3. Check if a device is causing the problem by removing
ALL attached devices (such as hard drives or optical
drives, and expansion cards). Power on the system. If
the system enters the POST, then power off and
replace one device at a time and repeat this procedure
until failure occurs. Replace the device that is causing
the failure. Continue adding devices one at a time to
ensure all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.
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Solving Hard Drive Problems
Table C-3  Solving Hard Drive Problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Microsoft Windows XP, right-click Start, click
Explore, and select a drive. Select File > Properties >
Tools. Under Error-checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click
Explore, and right-click on a drive. Select
Properties then select the Tools tab. Under Error-
checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with
a file.

In Microsoft Windows XP, right-click Start, click Explore,
and select a drive. Select File > Properties > Tools. Under
Error-checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click Explore,
and right-click on a drive. Select Properties then select the
Tools tab. Under Error-checking click Check Now.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 160 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

The device is attached to a SATA port that has been
disabled in Computer Setup.

Run the Computer Setup utility and ensure SATA1
Controller is Enabled in the Advanced menu.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been
disabled in Computer Setup.

Run the Computer Setup utility and ensure SATA1
Controller is Enabled in the Advanced menu.
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Computer will not boot from hard drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Boot > Boot Device Priority.

Hard drive is damaged. See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
off the power. To restart the computer, press the power
button again.

Solving Media Card Reader Problems
Table C-4  Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Microsoft Windows XP or Microsoft Windows Vista.

Cause Solution

By default, Windows XP and Windows Vista will format any
media card with a capacity greater than 32MB with the
FAT32 format. Most digital cameras use the FAT (FAT16 &
FAT12) format and can not operate with a FAT32 formatted
card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with
Windows XP or Windows Vista.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Table C-3  Solving Hard Drive Problems (continued)
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Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold
contact on the correct side. The green LED will light if
inserted properly.

Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. Open My Computer (Windows XP) or Computer (Windows
Vista), right-click on the corresponding drive icon, and select
Eject. Then pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized
by the computer.

Cause Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize whatever media is inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.

Table C-4  Solving Media Card Reader Problems (continued)
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Solving Display Problems
If you encounter display problems, see the documentation that came with the monitor and the
common causes and solutions listed in the following table.

Table C-5  Solving Display Problems

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and, if set, type your
password.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Monitor settings in the computer are not compatible with the
monitor.

1. In Windows XP Control Panel, double-click the Display
icon and select the Settings tab.

In Windows Vista Control Panel, under Appearance
and Personalization, select Adjust screen
resolution.

2. Use the sliding control to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the
input that is being driven by the system. Refer to the
monitor's user documentation for more information on the on-
screen controls and settings.

Cannot enable integrated graphics after installing a PCI Express graphics card.

Cause Solution

On systems with Intel integrated graphics, the integrated
graphics cannot be enabled after installing a PCI Express
x16.

The integrated graphics can be enabled in Computer Setup if
a PCI Express x1 graphics card is installed, but it cannot be
enabled if there is a graphics card in the PCI Express x16
slot.
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Blank screen and the computer emits one short beep then one long beep followed by a three second pause.

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the computer emits two short beeps then one long beep followed by a three second pause.

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the
graphics card and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.

Table C-5  Solving Display Problems (continued)
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The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them
apart.

3. Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.

“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what
the monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so
that the new settings take effect.

Vibrating or rattling noise coming from inside a CRT monitor when powered on.

Cause Solution

Monitor degaussing coil has been activated. None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Table C-5  Solving Display Problems (continued)
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Clicking noise coming from inside a CRT monitor.

Cause Solution

Electronic relays have been activated inside the monitor. None. It is normal for some monitors to make a clicking noise
when turned on and off, when going in and out of standby
mode, and when changing resolutions.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may
be unable to correctly interpret the output synchronization of
the graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions.

Graphics card is not seated properly or is bad. 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. Click Start > All Programs > Accessories >
System Tools > Character Map. You can copy the symbol
from the Character Map into a document.

Table C-5  Solving Display Problems (continued)
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Solving Audio Problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.

Table C-6  Solving Audio Problems

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Direct sound latency, common in many media player
applications.

In Windows XP only:

1. From the Control Panel, select Sounds and Audio
Devices.

2. On the Audio tab, select a device from the Sound
Playback list.

3. Click the Advanced button and select the Performance
tab.

4. Set the Hardware acceleration slider to None and the
Sample rate conversion quality slider to Good and
retest the audio.

5. Set the Hardware acceleration slider to Full and the
Sample rate conversion quality slider to Best and
retest the audio.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the
front headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.

Digital CD audio is not enabled. Enable digital CD audio. In the Device Manager, right-click
on the CD/DVD device and select Properties. Make sure
Enable digital CD audio for this CD-ROM device is
checked.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.
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Sound does not come out of the speaker or headphones.

Cause Solution

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select
Advanced > Internal Speaker.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Solving Printer Problems
If you encounter printer problems, see the documentation that came with the printer and the common
causes and solutions listed in the following table.

Table C-7  Solving Printer Problems

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Table C-6  Solving Audio Problems (continued)
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Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer is offline.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty. Select online.

Table C-7  Solving Printer Problems (continued)
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Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and the common causes and solutions listed in the following table.

Table C-8  Solving Keyboard Problems

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. 1. On the Windows XP Desktop, click Start > Shut Down.

On the Windows Vista Desktop, click Start, click the
arrow on the lower right corner of the Start menu, then
select Shut Down.

2. After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.

Table C-9  Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then
press the Enter key.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.
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Mouse does not respond to movement or is too slow.

Cause Solution

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.

Table C-9  Solving Mouse Problems (continued)
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non–plug and play device, you must reconfigure
the computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table C-10  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

USB ports on the computer are disabled in Computer Setup. Enter Computer Setup (F10) and enable the USB ports in
Advanced > USB Ports.

1394 ports on the computer are disabled in Computer Setup. Enter Computer Setup (F10) and enable the 1394 ports in
Advanced > Onboard 1394.

Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM2 must always be installed.

2. Listen for beeps from the computer. Beeps are codes
for specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.
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The computer emits one short beep then one long beep followed by a three second pause.

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM2 must always be installed.

3. Replace third-party memory with HP memory.

4. Replace the system board.

The computer emits two short beeps then one long beep followed by a three second pause.

Cause Solution

Graphics card is not seated properly or is bad, or system
board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Table C-10  Solving Hardware Installation Problems (continued)
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Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table C-11  Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows XP:

1. Select Start > Control Panel.

2. Double-click Network Connections.

3. Double-click Local Area Connection.

4. Click Properties.

5. Click Configure.

6. Click the Power Management tab, then select the
check box to Allow this device to bring the computer
out of standby.

To enable Wake-on-LAN in Windows Vista:

1. Select Start > Control Panel.

2. Under Network and Internet, select View network
status and tasks.

3. In the Tasks list, select Manage network connections.

4. Double-click Local Area Connection.

5. Click the Properties button.

6. Click the Configure button.

7. Click the Power Management tab, then select the
check box to Allow this device to wake the computer.

NOTE: Wake-on-LAN is only supported from the S1, S3
and S4 states. It is not supported from the S5 state.

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller in
Advanced > Onboard LAN.

2. Enable the network controller in the operating system
via Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.
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Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

Network controller is disabled. 1. Run Computer Setup and enable network controller in
Advanced > Onboard LAN.

2. Enable the network controller in the operating system
via Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into
the correct operating mode.

Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other
end of the cable.

Ensure that the cable and device at the other end are
operating correctly.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network icon in the Control Panel and configure
the network controller.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers.

Table C-11  Solving Network Problems (continued)
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Network controller stops working without apparent cause.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Table C-11  Solving Network Problems (continued)
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Solving Memory Problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off. To avoid
damage to the DIMMs or the system board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

Table C-12  Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 socket. Ensure that a memory module is installed in the black
DIMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for
the system or the new memory module is not seated
properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause Solution

Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.

You have run out of memory to run the application. Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs)
are installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.
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The computer emits one short beep then one long beep followed by a three second pause.

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table C-13  Solving CD-ROM and DVD Problems

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been
disabled in the Computer Setup utility.

Run the Computer Setup utility and ensure SATA1
Controller is Enabled in the Advanced menu.

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. 1. Run the Computer Setup utility and change the optical
drive boot priority in Boot > Boot Device Priority >
CD-ROM Group Boot Priority.

2. Run the Computer Setup utility and change boot group
sequence in Boot > Boot Device Priority.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 160 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

The device is attached to a SATA port that has been
disabled in Computer Setup.

Run the Computer Setup utility and ensure SATA1
Controller is Enabled in the Advanced menu.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Table C-12  Solving Memory Problems (continued)
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Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Table C-13  Solving CD-ROM and DVD Problems (continued)
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Solving USB Flash Drive Problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table C-14  Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been disabled
in Computer Setup.

Run the Computer Setup utility and ensure USB Ports are
Enabled in the Advanced menu.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. 1. Run the Computer Setup utility and change the
removable media boot priority in Boot > Boot Device
Priority.

2. Run the Computer Setup utility and change boot group
sequence in Boot > Boot Device Priority.

The image on the device is not bootable. Follow the procedures described in the "Replicating the
Setup" section of the Service Reference Guide.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.
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Solving Front Panel Component Problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.

Table C-15  Solving Front Panel Component Problems

A USB device, 1394 device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Enter Computer Setup (F10) and enable the USB ports in
Advanced > USB Ports.

1394 ports on the computer are disabled in Computer Setup. Enter Computer Setup (F10) and enable the 1394 ports in
Advanced > Onboard 1394.
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Solving Internet Access Problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Table C-16  Solving Internet Access Problems

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser
remember some specific information that the Web server can
later retrieve.)

Windows Vista

1. Select Start > Control Panel.

2. Click Network and Internet.

3. Click Internet Options.

4. In the Browsing history section on the General tab,
click the Delete button.

5. Click the Delete cookies button.

Windows XP

1. Select Start > Control Panel.

2. Double-click Internet Options.

3. On the General tab, click the Delete Cookies button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.
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Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating
properly.

Windows XP

1. Select Start > Control Panel.

2. Double-click System.

3. Click the Hardware tab.

4. In the Device Manager area, click the Device Manager
button.

5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.

Windows Vista

1. Select Start > Control Panel.

2. Click on System and Maintenance.

3. Click on System.

4. In the Tasks list, select Device Manager.

5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.

Table C-16  Solving Internet Access Problems (continued)
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Solving Software Problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Table C-17  Solving Software Problems

Computer will not continue and no HP logo screen has appeared.

Cause Solution

POST error has occurred. See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause Solution

System files may be damaged. Scan hard drive for errors.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your
version of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.

172 Appendix C   Troubleshooting Without Diagnostics



Interpreting POST Audible Codes
This section covers the audible codes that may occur before or during POST that do not necessarily
have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Beeps Meaning Recommended Action

1 short beep and 1 long beep
followed by a three second
pause

Bad memory or memory configuration
error.

Check that the memory modules have been
installed correctly and that proper modules are
used.

2 short beeps and 1 long beep
followed by a three second
pause

No graphics card installed or graphics
card initialization failed.

For systems with a graphics card:

1. Reseat the graphics card. Power on the
system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace
the system board.

3 short beeps and 1 long beep
followed by a three second
pause

CPU configuration error or invalid CPU
detected before graphics card
initialized.

1. Upgrade the BIOS to proper version.

2. Change the processor.

1 short beep followed by a one
second pause

No optical drive found. 1. Check cable connections.

2. Run the Computer Setup utility and ensure
the device port is enabled.

2 short beeps followed by a
three second pause

No CD found. 1. Check the type of drive that you are using
and use the correct media type.

2. Replace the CD with a new one.

3 short beeps followed by a
three second pause

Flashing not ready (missing utility or
BIOS image file, etc.)

Upgrade the BIOS to proper version.

4 short beeps followed by a
three second pause

Flashing operation has failed
(checksum error, corrupted image, etc.)

1. Verify the correct ROM.

2. Flash the ROM if needed.

3. If an expansion board was recently added,
remove it to see if the problem remains.

4. Clear CMOS.

5. If the message disappears, there may be a
problem with the expansion card.

6. Replace the system board.

5 short beeps followed by a
three second pause

BIOS recovery was successful No action required.
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Resetting the Password Jumper
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Hardware Reference Guide for more information.

3. Remove the computer cover or access panel.

4. Locate the header and jumper labeled CLEAR PW.

NOTE: The password jumper is light green so that it can be easily identified. For assistance
locating the password jumper and other system board components, see the Illustrated Parts &
Service Map (IPSM) for that particular system. The IPSM can be downloaded from
http://www.hp.com/support.

5. Remove the jumper from pins 2 and 3. Place the jumper on pins 1 and 2.

6. Replace the computer cover or access panel.

7. Reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

9. To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 2
and 3, then repeat steps 6 through 8. Establish the new passwords in Computer Setup. Refer to
the Computer Setup (F10) Utility Guide for Computer Setup instructions.
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Resetting the CMOS Jumper
1. Turn off the computer and any external devices, and disconnect the power cord from the power

outlet. The power must be disconnected from the system to clear CMOS.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Hardware Reference Guide for more information.

3. Remove the computer cover or access panel.

CAUTION: Resetting CMOS will restore the computer to factory defaults and will erase any
customized information including passwords, asset numbers, and special settings.

4. Locate the header and jumper labeled CLEAR CMOS.

NOTE: Be sure you have disconnected the AC power cord from the wall outlet. The CMOS will
not clear if the power cord is connected.

NOTE: The CMOS jumper is light green so that it can be easily identified. For assistance
locating the CMOS jumper and other system board components, see the Illustrated Parts &
Service Map (IPSM) for that particular system. The IPSM can be downloaded from
http://www.hp.com/support.

5. Remove the CMOS jumper from pins 2 and 3 and put the jumper on pins 1 and 2. This clears
CMOS.

6. Put the jumper back on pins 2 and 3.

7. Replace the computer cover or access panel.

8. Reconnect the external devices.

9. Plug in the computer and turn on power.

NOTE: Use Computer Setup to reset any special system setups along with the date and time.

For instructions on Computer Setup, see the Computer Setup (F10) Utility Guide.
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Contacting Customer Support
For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.

NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.

Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.
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D Specifications

Microtower
Table D-1  Specifications – HP Pro 3015 Microtower

Desktop Dimensions

Height

Width

Depth

15.14 in

7.27 in

16.36 in

385 mm

185 mm

416 mm

Approximate Weight 23.5 lb 10.66 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

Relative Humidity (noncondensing)

Operating

Nonoperating (38.7°C max wet bulb)

10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no
direct sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and
number of options installed.
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Heat Dissipation

Maximum

For 115V/60Mhz

250W PFC HV ATX:

170.8W or 582.77 BTU/
hr

300W PFC HV ATX:

173.3W or 591.3 BTU/hr

300W NPFC ATX:

174.9W or 596.76 BTU/
hr

300W 85% EFF ATX:

157.8W or 538.41 BTU/
hr

250W PFC HV TFX:

173.9W or 593.35 BTU/
hr

250W PFC TFX:

179.2W or 611.43 BTU/
hr

For 115V/60Mhz

250W PFC HV ATX:

170.0W or 580.04
BTU/hr

300W PFC HV ATX:

169.2W or 577.31
BTU/hr

300W NPFC ATX:

175.0W or 596.42
BTU/hr300W 85% EFF
ATX:

153.4W or 523.4 BTU/
hr

250W PFC HV TFX:

172.3W or 587.89
BTU/hr

250W PFC TFX:

174.8W or 596.42
BTU/hr

Typical (idle) For 115V/60Mhz

250W PFC HV TFX:

173.9W or 593.35 BTU/
hr

250W PFC TFX:

179.2W or 611.43 BTU/
hr

For 115V/60Mhz

250W PFC HV TFX:

173.9W or 593.35
BTU/hr

250W PFC TFX:

179.2W or 611.43
BTU/hr

Power Supply

Operating Voltage Range

Rated Voltage Range

Rated Line Frequency

115V

90-132 VAC

100-127 VAC

50-60 Hz

230V

180-264 VAC

200-240 VAC

50-60 Hz

Power Output 300 W 300 W

Rated Input Current (maximum)1 8A @ 100 VAC 4A @ 200 VAC

1 This system utilizes a passive power factor corrected power supply. The power factor correction is present in the 230V
operating mode only. This allows the system to pass the CE mark requirements for use in the countries of the European
Union. This supply requires the use of an input voltage range select switch.

Table D-1  Specifications – HP Pro 3015 Microtower (continued)
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Table D-2  Specifications – HP Pro 3015 Microtower

Desktop Dimensions

Height

Width

Depth

15.14 in

7.27 in

16.36 in

385 mm

185 mm

416 mm

Approximate Weight 23.5 lb 10.66 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

Relative Humidity (noncondensing)

Operating

Nonoperating (38.7°C max wet bulb)

10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no
direct sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and
number of options installed.

Power Supply

Operating Voltage Range

Rated Voltage Range

Rated Line Frequency

115V

90-132 VAC

100-127 VAC

50-60 Hz

230V

180-264 VAC

200-240 VAC

50-60 Hz

Power Output 300 W 300 W

Rated Input Current (maximum)1 8A @ 100 VAC 4A @ 200 VAC

1 This system utilizes a passive power factor corrected power supply. The power factor correction is present in the 230V
operating mode only. This allows the system to pass the CE mark requirements for use in the countries of the European
Union. This supply requires the use of an input voltage range select switch.
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Small Form Factor
Table D-3  Specifications – HP Pro 3000/3080 Small Form Factor

Desktop Dimensions

Height

Width

Depth

3.98 in

13.35 in

15.24 in

101 mm

339 mm

387 mm

Approximate Weight 14.95 lb 6.81 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

Relative Humidity (noncondensing)

Operating

Nonoperating (38.7°C max wet bulb)

10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no
direct sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and
number of options installed.

Heat Dissipation

Maximum

For 115V/60Mhz

250W PFC HV TFX:

173.9W or 593.35 BTU/
hr

250W PFC TFX:

179.2W or 611.43 BTU/
hr

For 230V/50Hz

250W PFC HV TFX:

172.3W or 587.89
BTU/hr 250W PFC
TFX:

174.8W or 596.42
BTU/hr

Typical (idle) For 115V/60Mhz

250W PFC HV TFX:

51.9W or 177.0828 BTU/
hr

250W PFC TFX:

52.8W or 180.1536 BTU/
hr

For 230V/50Hz

250W PFC HV TFX:

51.4W or 175.3768
BTU/hr

250W PFC TFX:

53.3W or 181.8596
BTU/hr

Power Supply

Operating Voltage Range

Rated Voltage Range

Rated Line Frequency

115V

90-132 VAC

100-127 VAC

50-60 Hz

230V

180-264 VAC

200-240 VAC

50-60 Hz

180 Appendix D   Specifications



Power Output 300 W 300 W

Rated Input Current (maximum)1 8A @ 100 VAC 4A @ 200 VAC

1 This system utilizes a passive power factor corrected power supply. The power factor correction is present in the 230V
operating mode only. This allows the system to pass the CE mark requirements for use in the countries of the European
Union. This supply requires the use of an input voltage range select switch.

Table D-4  Specifications – HP Pro 3010 Small Form Factor

Desktop Dimensions

Height

Width

Depth

3.98 in

13.35 in

15.24 in

101 mm

339 mm

387 mm

Approximate Weight 14.95 lb 6.78 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

Relative Humidity (noncondensing)

Operating

Nonoperating (38.7°C max wet bulb)

10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no
direct sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and
number of options installed.

Heat Dissipation

Maximum

Typical (idle)

1575 BTU/hr

307 BTU/hr

397 kg-cal/hr

77 kg-cal/hr

Power Supply

Operating Voltage Range

Rated Voltage Range

Rated Line Frequency

115V

90-132 VAC

100-127 VAC

50-60 Hz

230V

180-264 VAC

200-240 VAC

50-60 Hz

Power Output 300 W 300 W

Rated Input Current (maximum)1 8A @ 100 VAC 4A @ 200 VAC

1 This system utilizes a passive power factor corrected power supply. The power factor correction is present in the 230V
operating mode only. This allows the system to pass the CE mark requirements for use in the countries of the European
Union. This supply requires the use of an input voltage range select switch.

Table D-3  Specifications – HP Pro 3000/3080 Small Form Factor (continued)
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Index

Symbols/Numerics
24-pin power pin

assignments 136
4-pin power pin assignments 135

A
access panel

removal and replacement 36
SFF removal and

replacement 85
access panel, locked 145
audio

connectors 4, 6, 7, 8, 9, 10
audio problems 155

B
battery

disposal 34
removal and replacement 75
SFF removal and

replacement 126
beeps, error codes 141
bezel blanks

SFF removal and
replacement 87

C
cable connections

HP Pro 3000/3080 50, 51
HP Pro 3000/3080 SFF 100

cable management 49, 99
cable pinouts

SATA data 25
cautions

AC power 27
cables 33
cooling fan 32
electrostatic discharge 27
keyboard cleaning 31
keyboard keys 32

CD-ROM or DVD problems 166
chassis security kit 83, 133
cleaning

computer 31
mouse 32
safety precautions 31

CMOS
resetting jumper 175

computer cleaning 31
computer setup utility

HP Pro 3000 MT/3080 MT 13
HP Pro 3010 MT 19

connecting drive cables 53, 102
connections

system board 50, 51, 100
connector pin assignments 134
country power cord set

requirements 140
Customer Support 141, 176

D
Digital Audio Out connector 7, 10
disassembly preparation

SFF 84
diskette drive, SFF

installing 110
removing 108

drive connectors 54, 103
drives

connecting cables 53, 102
installing 53
installing, SFF 102
locations 52, 101
removal and replacement 52
SFF removal and

replacement 101
DVI connector 6, 7, 9, 10

E
electrostatic discharge (ESD)

preventing damage 28
error codes 141
ethernet

BNC pin assignments 134
expansion card

sockets 44, 45, 94, 95
expansion slot cover

removing 46
replacing 48

expansion slot cover, SFF
removing 96
replacing 98

F
F10 setup

HP Pro 3000 MT/3080 MT 13
HP Pro 3010 MT 19

fan
power supply 32
removal and replacement 69

flash drive problems 168
front bezel

removal and replacement 37
SFF removal and

replacement 86
front I/O device

removal and replacement 67
SFF removal and

replacement 119
front panel components 4, 8
front panel problems 169

G
general problems 144
grounding methods 28
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H
hard drive

installing 63
proper handling 33
removing 60
SATA characteristics 25

hard drive problems 148
hard drive, SFF

removing 113
hardware installation

problems 142
headphone connector 4, 8
headphone pin assignments 135
heat sink

removal and replacement 70
heatsink

SFF removal and
replacement 121

helpful hints 141
hood sensor 82, 132

I
installing

diskette drive, SFF 110
drive cables 53, 102
hard drive 63
media card reader 59, 110
optical drive 57
optical drive, SFF 106

Internet access problems 170

J
jumper

CMOS 175
password 174

K
keyboard

cleaning 31
keyboard connector 6, 9
keyboard problems 158

L
line-in audio pin

assignments 135
line-in connector 6, 7, 9, 10
line-out audio pin

assignments 135
line-out connector 6, 7, 9, 10
locks

cable lock 79, 129

HP Business PC Security
Lock 80, 130

padlock 79, 129

M
media card reader

features 5
installing 59, 110
removing 58, 108

Media Card Reader
problems 149

memory
populating sockets 40, 89
removal and replacement 39
SFF removal and

replacement 88
specifications 39, 88

memory problems 165
microphone

connector 4, 6, 7, 8, 9, 10
microphone pin assignments 134
monitor

pin assignments 136
monitor connector 6, 7, 9, 10
monitor problems 151
mouse

cleaning 32
mouse connector 6, 9
mouse problems 158

N
network connector 6, 7, 9, 10
network problems 162

O
operating guidelines 30
optical drive

installing 57
removing 56

optical drive problems 166
optical drive, SFF

installing 106
removing 105

overheating, prevention 30

P
password

resetting jumper 174
PCI card 47
PCI Express

card 44, 45, 47, 94, 95, 97

PCI Express pin
assignments 137

plastic wire fastener
SFF removal and

replacement 117
POST error codes 141
power cord set requirements

country specific 140
power problems 147
power supply

fan 32
removal and replacement 72
SFF removal and

replacement 123
power switch assembly

SFF removal and
replacement 120

power switch/LED
removal and replacement 68

preparation for disassembly 35
printer problems 156
problems

audio 155
CD-ROM or DVD 166
flash drive 168
front panel 169
general 144
hard drive 148
hardware installation 142
Internet access 170
keyboard 158
Media Card Reader 149
memory 165
monitor 151
mouse 158
network 162
power 147
printer 156
software 172

processor
removal and replacement 71
SFF removal and

replacement 122

R
rear center channel audio

connector 7, 10
rear channel audio

connector 7, 10
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rear panel components
HP Pro 3000 MT/3080 MT 6
HP Pro 3000 SFF 9
HP Pro 3010 MT 7
HP Pro 3010 SFF 10

recovery/reset button 4
removal and replacement

access panel 36
battery 75
drives 52
fan 69
front bezel 37
front I/O device 67
heat sink 70
memory 39
power supply 72
power switch 68
processor 71
SFF access panel 85
SFF battery 126
SFF bezel blanks 87
SFF drives 101
SFF front bezel 86
SFF front I/O device 119
SFF heatsink 121
SFF memory 88
SFF plastic wire fastener 117
SFF power supply 123
SFF power switch

assembly 120
SFF processor 122
SFF system board 125
system board 74

removing
diskette drive, SFF 108
expansion slot cover 46
expansion slot cover, SFF 96
hard drive 60
hard drive, SFF 113
media card reader 58, 108
optical drive 56
optical drive, SFF 105
PCI card 47
PCI Express card 47
PCI Express x1 card 97
PCI Express x16 card 97

S
safety and comfort 141

safety precautions
cleaning 31

SATA
connectors on system

board 25
data cable pinouts 25
hard drive characteristics 25

screws, correct size 33
SDRAM (synchronous dynamic

random access memory 39
security

cable lock 79, 129
hood sensor 82, 132
HP Business PC Security

Lock 80, 130
HP Chassis Security

Kit 83, 133
padlock 79, 129

serial connector 6, 9
service considerations 32
serviceability features 4, 8
setup utility

HP Pro 3000 MT/3080 MT 13
HP Pro 3010 MT 19

SFF
access panel removal and

replacement 85
battery removal and

replacement 126
bezel blank removal and

replacement 87
disassembly preparation 84
drives removal and

replacement 101
front bezel removal and

replacement 86
front I/O device removal and

replacement 119
heatsink removal and

replacement 121
memory removal and

replacement 88
plastic wire fastener removal

and replacement 117
power supply removal and

replacement 123
power switch assembly removal

and replacement 120
preparation for

disassembly 84

processor removal and
replacement 122

system board removal and
replacement 125

SFF specifications
memory 88

side channel audio
connector 7, 10

software
problems 172
servicing computer 32

spare part number
tamper-resistent wrench 33
Torx T-15 screwdriver 32

specifications
memory 39
microtower 177
small form factor 180

static electricity 27
subwoofer audio connector 7, 10
system board

removal and replacement 74
SATA connectors 25
SFF removal and

replacement 125
system board drive

connections 54
system board drive

connectors 103

T
tamper-proof screws

tool 33
temperature control 30
tools, servicing 32
Torx T15 screwdriver 32

U
USB pin assignments 134
USB ports

front panel 4, 8
rear panel 6, 7, 9, 10

V
ventilation, proper 30
VGA monitor connector 9, 10

W
Wake-on-LAN feature 162
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